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THIS PRODUCT CONTAINS CERTAIN COMPUTER PROGRAMS AND OTHER PROPRIETARY MATERIAL, THE USE OF WHICH IS SUBJECT TO
THIS END-USER LICENSE AGREEMENT (THE "TAGREEMENT"). DO NOT PROCEED WITH THE INSTALLATION OF THIS PRODUCT UNTIL YOU
(LATER DEFINED AS LICENSEE) HAVE READ THIS AGREEMENT AND AGREE TO BE BOUND BY AND BECOME A PARTY TO THIS
AGREEMENT. BY PROCEEDING WITH THE INSTALLATION OF THIS PRODUCT (OR AUTHORIZING ANY OTHER PERSON TO DO SO), YOU
AND YOUR COMPANY ACCEPT THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, YOU MAY EXIT THE
INSTALLATION PROCESS AND RETURN THIS PRODUCT, ALL MEDIA AND DOCUMENTATION, AND PROOF OF PAYMENT, TO THE PLACE
YOU OBTAINED THEM FOR A FULL REFUND WITHIN TEN (10) DAYS OF FIRST ACQUIRING THIS PRODUCT. WRITTEN APPROVAL IS NOT A
PREREQUISITE TO THE VALIDITY OR ENFORCEABILITY OF THIS AGREEMENT AND NO SOLICITATION OF ANY SUCH WRITTEN APPROVAL
BY OR ON BEHALF OF LEGATO SHALL BE CONSTRUED AS AN INFERENCE TO THE CONTRARY. IF YOU HAVE ORDERED THIS PRODUCT,
LEGATO'S ACCEPTANCE IS EXPRESSLY CONDITIONAL ON YOUR ASSENT TO THESE TERMS TO THE EXCLUSION OF ALL OTHER TERMS; IF
THESE TERMS ARE CONSIDERED AN OFFER BY LEGATO, ACCEPTANCE IS EXPRESSLY LIMITED TO THESE TERMS.

1. DEFINITIONS

1.1 Authorization Code: means the code Frovided to Licensee by Legato
for permanent authorization to use the Software. The Authorization Code
is provided to Licensee once the Enabler Code is registered with Legato.

1.2 Documentation: means any user reference materials on any media,
provided by Legato for use with the Software.

1.3 Enabler Code: means the code provided by Legato for activation of the
Software.

1.4 Licensee: means the person or entity acquiring this License or for
whom this License was acquired.

1.5 Software means the object code copy of the software program provided
to You in association with this Agreement, together with the associated
original electronic media and all accompanying manuals and other
documentation, and together with all enhancements, upgrades, and
extensions thereto that may be provided by Legato to You from time to
time.

2. OWNERSHIP AND ADMINISTRATION OF SOFTWARE

2.1 Ownership and Title. Asbetween the parties, Legato, and its licensors,
own and shall retain all right, title, and interest in and to: (i) the Software
including all intellectual property rights embodied therein; (ii) all of the
service marks, trademarks, trade names, or any other designations
associated with the Software; and (iii) all copyrights, patent rights, trade
secret rights, and other proprietary rights relating to the Software.
Licensee further acknowledges and agrees that it shall have no rights with
respect to any of the foregoing rights other than the rights expressly set
forth in this Agreement.

2.2 Software Activation. Legato employs Enabler Codes and
Authorization Codes that enable the use of the Software. The Software is
shipped in a "Media Kit" which consists of object code software on
CD-ROM and an Enabler Code for initial activation of the Software or the
Software and Enabler Code may be delivered electronically. Once Legato
receives confirmation from Licensee that the Enabler Code is installed and
is provided with the host ID information, Legato will provide the
Authorization Code to Licensee. Legato administers the generation and
distribution of Enabler and Authorization Codes, which administration
may be modified by Legato from time to time.

2.3 Administration of Software. Legato may include on the media with the
Software additional computer programs which are not currently licensed
for use by Licensee and to which the Enabler Code or Authorization code
will not permit access. Inclusion of such additional computer programs in
no way implies a license from Legato and access or use of such programs
is strictly prohibited unless Licensee procures the right to use any such
program and the applicable Enabler Code is provided thereto.

3. LICENSE GRANT

3.1 Grant. Legato grants to Licensee a non-exclusive, nontransferable,
non-sublicensable, perpetual, unless terminated in accordance with the
provisions of this Agreement, license (the "License") to (i) use the Software
installed in accordance with the Documentation and only on the licensed
computer solely for its own internal operations; and (ii) move the Software
temporarily in case of computer system malfunction. The License granted
under this Agreement does not constitute a sale of the Software or any
portion or copy of it. Licensee may not use the Software on more than one
computer system unless otherwise specifically authorized by an explicit
Software product, or additional licenses for additional computers are
purchased. Rights not expressly granted are reserved by Legato. Where
the Software is provided to Licensee at no charge for evaluation purposes
only, the License granted is limited to a continuous thirty (30) day period,
commencing with the acceptance of this Agreement (the "Evaluation
Period"). At the conclusion of the Evaluation Period, Licensee agrees to
destroy the Software and certify its destruction to Legato, in writing,
within ten (10) days, or shall return the Software to Legato or purchase a
perpetual license.

3.2 Copies. Licensee may make copies of the Software provided that any
such copy is : (i) created as an essential step in utilization of the Software
on the licensed computer and is used in no other manner; or (ii) used for
archival purposes to back-up the licensed computers. All trademark and
copyright notices must be reproduced and included on such copies.
Licensee may not make any other copies of the Software.

3.3 Restrictions on use. Licensee shall not, and shall not aid, abet, or permit
any third party to: (i) decompile, disassemble, or otherwise reverse
engineer or attempt to reconstruct or discover any source code or
underlying ideas or algorithms of the Software by any means whatsoever;
(ii) remove any identification, copyright, or other notices from the
Software; (iii) provide, lease, lend, use for timesharing or service bureau
purposes, or otherwise use or allow others to use the Software or any
portion thereof to or for the benefit of third parties; (iv) create a derivative
work of any part of the Software; or (v) develop methods to enable
unauthorize garties to use the Software. If EC law is applicable, the
restrictions in Section 3.3 (i) are limited so that they prohibit such activity
onlff to the maximum extent such activity may be prohibited without
violating the EC Directive on the legal protection of computer programs.
Notwithstanding the foregoing, prior to decompiling, disassembling, or
otherwise reverse engineering any of the Software, Licensee shall request
Legato in writing, to provide Licensee with such information or assistance
and Licensee shall refrain from decompiling, disassembling, or otherwise
reverse engineering any of the Software unless Legato cannot or has not
complied with such request in a commercially reasonable amount of time.

3.4 Purchase Orders. Nothing contained in any purchase order,
acknowledgment, or invoice shall in any way modify the terms or add any
additional terms or conditions to this Agreement.

3.5 Updates. This section applies if the Software acquired is an update to
the original Software ( the "Update"). An Update does not constitute a
legally licensed copy of the Software unless purchased as an Update to a
previous version of the same Software. The Update may only be used in
accordance with the provisions of this Agreement. The Update, together
Wi}h the original Software, constitute one (1) legally licensed copy of the
Software.

3.6 Evaluation License. This Section applies if the Software is being used
for an initial thirty (30) day evaluation period. The license is valid only for
a period of thirty (30) days from the delivery of the Software, and is
designed to allow Licensee the right to evaluate the Software during such
Feriod. In the event that Licensee desires to enter into a longer-term
icense agreement with Legato, Licensee shall obtain an appropriate
Enabler and Authorization Code in accordance with Section 2.2 above,
upon payment of applicable fees, which authorizes use of the Software
after such evaluation period, but only subject to all of the terms and
conditions of this Agreement. In the event Licensee determines not to
enter into a licensing transaction with Legato at the end of such thirty (30)
day evaluation period, then Licensee's rights under this Agreement shall
terminate automatically and Licensee shall promptly return to Legato or
destroy all copies of the Software and so certify to Legato.

4. MAINTENANCE AND SUPPORT

4.1 Legato has no obligation to provide support, maintenance, upgrades,
modifications, or new releases under this Agreement. Legato may provide
such services under separate agreement.

5. LIMITED WARRANTY

5.1 Media and Documentation. Legato warrants that if the media or
documentation are damaged or physically defective at the time of delivery
of the first copy of the So%tware to Licensee and if defective or damaged
product is returned to Le§at0 (postage prepaid) within thirty (30) days
thereafter, then Legato will provide Licensee with replacements at no cost.

5.2 Software. Subject to the conditions and limitations of liability stated
herein, Legato warrants for a period of thirty (30) days from the delivery
of the first copy of the Software to Licensee that the Software, as delivered,
will materially conform to Legato's then current published
Documentation for the Software. This warranty covers only problems
reported to Legato during the warranty period.



5.3 Remedies. The remedies available to Licensee hereunder for any such
Software which does not perform as set out herein shall be either repair or
replacement, or, if such remedy is not practicable in Legato's opinion,
refund of the license fees 1Izaid by Licensee upon a return of all copies of the
Software to Legato. In the event of a refund this Agreement shall
terminate immediately without notice.

6. TERM AND TERMINATION

6.1 Term. The term of this Agreement is perpetual unless terminated in
accordance with its provisions.

6.2 Termination. Legato may terminate this Agreement, without notice,
upon Licensee's breach of any of the provisions hereof.

6.3 Effect of Termination. Upon termination of this Agreement, Licensee
agrees to cease all use of the Software and to return to Legato or destroy
the Software and all Documentation and related materials in Licensee's
possession, and so certify to Legato. Except for the License granted herein
and as expressly provided herein, the terms of this Agreement shall
survive termination.

7. DISCLAIMER AND LIMITATIONS

7.1 Warranty Disclaimer. EXCEPT FOR THE LIMITED WARRANTY
PROVIDED IN SECTION 5 ABOVE, LEGATO MAKES NO
WARRANTIES WITH RESPECT TO ANY SOFTWARE AND DISCLAIMS
ALL STATUTORY OR IMPLIED WARRANTIES, INCLUDING
WITHOUT LIMITATION WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR ARISING FROM A
COURSE OF DEALING OR USAGE OF TRADE AND ANY
WARRANTIES OF NONINFRINGEMENT. ALL SOFTWARE IS
PROVIDED "AS IS" AND LEGATO DOES NOT WARRANT THAT THE
SOFTWARE WILL MEET ANY REQUIREMENTS OR THAT THE
OPERATION OF SOFTWARE WILL BE UNINTERRUPTED OR ERROR
FREE. ANY LIABILITY OF LEGATO WITH RESPECT TO THE
SOFTWARE OR THE PERFORMANCE THEREOF UNDER ANY
WARRANTY, NEGLIGENCE, STRICT LIABILITY OR OTHER THEORY
WILL BE LIMITED EXCLUSIVELY TO THE REMEDIES SPECIFIED IN
SECTION 5.3 ABOVE. Some jurisdictions do not allow the exclusion of
implied warranties or limitations on how long an implied warranty may
last, so the above limitations may not be applicable. This warranty
Erovides specific legal rights. Other rights vary from state to state.

icensee acknowledges and agrees that Legato is not responsible for and
will have no liability for hardware, software, or other items or services
provided by persons other than Legato.

8. LIMITATION OF LIABILITY

8.1 Limitation of Liability. NOTWITHSTANDING ANYTHING ELSE IN
THIS AGREEMENT OR OTHERWISE, AND EXCEPT FOR BODILY
INJURY, LEGATO WILL IN NO EVENT BE LIABLE OR RESPONSIBLE
FOR OR OBLIGATED WITH RESPECT TO THE SUBJECT MATTER OF
THIS AGREEMENT UNDER ANY CONTRACT, NEGLIGENCE, STRICT
LIABILITY, OR OTHER LEGAL CONTRACTUAL OR EQUITABLE
THEORY FOR: (I) ANY INDIRECT, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES, HOWEVER CAUSED AND WHETHER
OR NOT ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH
DAMAGES,; OR (II) DAMAGES FOR LOST PROFITS OR LOST DATA; OR
(ITT) COST OF PROCUREMENT OF SUBSTITUTE GOODS,
TECHNOLOGY, SERVICES, OR RIGHTS; OR (IV) FOR ANY MATTER
BEYOND ITS REASONABLE CONTROL. NOTWITHSTANDING
ANYTHING IN THIS AGREEMENT TO THE CONTRARY OR THE
FAILURE OF ESSENTIAL PURPOSE OF ANY LIMITATION OF
LIABILITY OR LIMITED REMEDY, LEGATO'S ENTIRE AGGREGATE
LIABILITY ARISING FROM OR RELATING TO THIS AGREEMENT OR
THE SUBJECT MATTER HEREOF, UNDER ANY LEGAL THEORY
(WHETHER IN CONTRACT, TORT, INDEMNITY OR OTHERWISE)
SHALL BE LIMITED TO THE AMOUNTS RECEIVED BY LEGATO FOR
THE SOFTWARE DURING THE SIX (6) MONTH PERIOD PRIOR TO
THE DATE THE CLAIM AROSE FOR THE PARTICULAR LEGATO
SOFTWARE THAT CAUSED THE LIABILITY.

9. MISCELLANEOUS

9.1 Governing Law. This Agreement shall be governed by the laws of the
State of California, as applied to agreements entered into and to be
performed entirely witﬁin California between California residents,
without regard to the principles of conflict of laws or the United Nations
Convention on Contracts for the International Sale of Goods.

9.2 Government Restricted Rights. This provision applies to Software
ac?uired directly or indirectly by or on behalf of any government. The
Software is a commercial software product, licensed on the open market at
market prices, and was developed entirely at private expense and without
the use of any government funds. Any use, modification, reproduction,
release, performance, display, or disclosure of the Software by any
government shall be governed solely by the terms of this Agreement and
shall be prohibited except to the extent expressly permitted by the terms of
this Agreement, and no license to the Software is granted to any
government requiring different terms.

9.3 U.S. Government Users. As defined in FAR section 2.101, DFAR section
252.227-7014(a)(1), DFAR section 252.227-7014(a)(5), or otherwise, all
software and accompanying documentation provided in connection with
this Agreement are "commercial items,” "commercial computer software"
and/or "commercial computer software documentation." Consistent with
DFAR section 227.7202 and FAR section 12.212, any use, modification,
reproduction, release, performance, dislflla , disclosure, or distribution
thereof by or for the U.S. Government shall be governed solely by the
terms of this Agreement and shall be prohibited except to the extent
expressly permitted by the terms of this Agreement. Licensee will ensure
that each copy used or possessed by or for the government is labeled to
reflect the foregoing.

9.4 Export and Import Controls. Regardless of any disclosure made by
Licensee to Legato of an ultimate destination of the Products, Licensee will
not directly or indirectly export or transfer any portion of the Software, or
any system containing a E)ortion of the Software, to anyone outside the
United States (including further export if Licensee took delivery outside
the U.S.) without first complying with any export or import controls that
may be imposed on the Software by the U.S. Government or any country
or organization of nations within whose jurisdiction Licensee operates or
does business. Licensee shall at all times strictly comply with all such
laws, regulations, and orders, and agrees to commit no act which, directly
or indirectly, would violate any such law, regulation or order.

9.5 Assignment. This Agreement may not be assigned or transferred by
Licensee without the prior written consent of Legato which shall not be
unreasonably withheIl():l. Legato may assign or otherwise transfer any or all
of its rights and obligations under this Agreement upon notice to Licensee.

9.6 Sole Remedy and Allocation of Risk. Licensee's sole and exclusive
remedy is set forth in this Agreement. This Agreement defines a mutually
agreed-upon allocation of risk, and the License price reflects such
allocation of risk.

9.7 Equitable Relief. The parties agree that a breach of this Agreement
adversely affecting Legato's intellectual property rights in the Software
may cause irreparable injury to Legato for which monetary damages may
not be an adequate remedy and Legato shall be entitled to equitable relief
in addition to any remedies it may have hereunder or at law.

9.8 No Waiver. Failure by either party to enforce any provision of this

Agreement will not be deemed a waiver of future enforcement of that or
any other provision, nor will any single or partial exercise of any right or
power hereunder preclude further exercise of any other right hereunder.

9.9 Severability. If for any reason a court of competent jurisdiction finds

any provision of this Agreement, or portion thereof, to be unenforceable,
that provision of the Agreement will be enforced to the maximum extent
permissible so as to effect the intent of the parties, and the remainder of

this Agreement will continue in full force and effect.

10. ENTIRE AGREEMENT

10.1 This Agreement sets forth the entire understanding and agreement
between the parties and may be amended only in a writing signed by
authorized representatives of both parties. No vendor, distributor, dealer,
retailer, sales person, or other person is authorized by Legato to modify
this Agreement or to make any warranty, representation, or promise which
is different than, or in addition to, the warranties, representations, or
promises made in this Agreement.
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Audience

Preface

The Legato NetWorker® Module for Microsoft® Exchange Server Administrator’s
Guide contains information on how to configure and manage the Legato
NetWorker Module for Microsoft Exchange Server, Release 3.0 software.

You must install the NetWorker Module software on your server and clients to
use the information presented in this guide. If you have not yet installed the
software, refer to the Legato NetWorker Module for Microsoft Exchange Server
Installation Guide for installation instructions.

The information in this guide is intended for system administrators who are
responsible for installing software and maintaining the servers and clients on
a network. Operators who monitor the daily backups may also find this
manual useful.

Product Documentation

Legato offers an extensive archive of product documentation at its web site
www.legato.com. Most of the documents are in Adobe® Acrobat® Portable
Document Format (PDF), and can be viewed by downloading and installing
the Adobe Acrobat Reader. The Reader is available in the /fviewers/acroread
directory on the Legato Documentation Suite CD-ROM, or directly from
Adobe at www.adobe.com. To install and use the Reader on the platform of your
choice, refer to the instructions in the CD-ROM’s /fviewers/acroread/readme.txt
file or at the Adobe web site.

Legato NetWorker Module for Microsoft Exchange Server
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Conventions

Conventions

This document uses the following typographic conventions and symbols to
make information easier to access and understand.

Convention

ndicates

B

xample

boldface

Names of DOS or UNIX line
commands, daemons,
options, programs, or scripts

The nsradmin command starts the
command line version of the administration
program.

italic in text

Pathnames, filenames,
computer names, new terms
defined in the Glossary or
within the chapter, or
emphasized words

Displayed messages are also written to
/mst/logs/daemon.log.

italic in command
line

A variable that you need to
provide in the command line

nwadmin -s  server-name

fixed-width Examples and information | media waiting: recover waiting for
displayed on the screen 8mm 5GB tape volume name

fixed-width, Commands and options that | nsr_shutdown -a

boldface you must type exactly as

shown

Menu_Name>

A path or an order to follow

Volume>Change Mode>Appendable

Command for making selections in the
GUI
Important: Information that you must
read and follow to ensure A
successful backup and Important: You must install the NetWorker
recovery of your data Module software in the same directory
where you installed the NetWorker client
binaries.
Legato NetWorker Module for Microsoft Exchange Server
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Preface

Information and Services

Legato offers a variety of methods, including electronic, telephone, and fax
support, for you to obtain company, product, and technical information.

General Information

The Legato web site provides most of the information that you might need. If
you want technical bulletins and binary patches, you can also access the
Legato FIP site. If you have specific sales or training needs, e-mail or call
Legato.

Company &
Legato Service or Technical |Binary |Product Training
Resource 2 Bulletins | Patches |Information |Programs

www.legato.com Yes Yes Yes Yes

ftp.legato.com Yes Yes
(log in as anonymous)

Legato Inside Sales, Yes
(408) 530-3000 or
sales@legato.com

Legato Education Services, Yes
(408) 530-3099 or
training@legato.com

a. For detailed information about our services, support policies, and software subscriptions, refer
to the Legato Customer Service and Support Guide included in the media kit.

Technical Support

The Support section of the Legato web site provides contact information,
software patches, technical documentation, and information about available
support programs.

* If you have an active support agreement, you may access TechDialog, the
Legato integrated product knowledge base. You may also contact Legato
Technical Support for help with Legato software issues.

¢ If you do not have an active support agreement, contact LegatoCare to
purchase annual Software Update Subscriptions, Legato Technical
Support services, or per-update/per-incident support.

Legato NetWorker Module for Microsoft Exchange Server
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Customer Service

Customer Service

Legato provides a variety of ways for you to contact Customer Service. To
register your Legato products, go to the Legato licensing web site. To ask
questions about licensing, to transfer licenses, or to learn the status of your
order, contact Legato using one of the following methods.

Customer Service Contact

Legato licensing web site http://license.legato.com
Telephone number (650) 812-6063 (option 3)
Fax number (650) 812-6220

E-mail service@legato.com
E-mail for order status order_admin@legato.com

Customer Feedback

Legato welcomes your comments and suggestions about software features, the
installation procedure, and documentation. Please send any suggestions and
comments to feedback@legato.com. You will receive a notice confirming receipt
of your e-mail. Although we cannot respond personally to every request, we
consider all your comments and suggestions during product design.

Help us improve our documentation and be eligible to win a prize by
completing a brief survey. Visit the Legato web site at www.legato.com, go to the
Technical Documentation page, and then look for the link to the Legato
Documentation Survey.

Legato NetWorker Module for Microsoft Exchange Server
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Chapter 1: Introduction

The Legato NetWorker Module for Microsoft Exchange Server software
provides services that enable the Legato NetWorker server to back up and
restore Microsoft Exchange Server objects. The NetWorker Module software
integrates this capability into the comprehensive, network-wide data
protection solution that Legato NetWorker® software provides for the
Microsoft Windows NT®, Microsoft Windows® 2000, and UNIX® operating
systems.

Importance of Backing Up Microsoft Exchange Server Data

In a client-server environment, data can be lost due to hardware failures,
software bugs, procedural flaws, and user errors. A viable database backup
strategy can help you recover your data in the event of such a disaster.

There is considerable risk in failing to perform regular backups of databases
and frequent backups of transaction logs. If all transaction logs are lost, a
database can be recovered only to the time of its last full backup. Without
backups or transaction logs, the database cannot be recovered at all.

Without a centralized storage management solution, backups of mission-
critical data must be implemented at the local system level. Local backups do
not provide a cohesive policy for managing and protecting vital,
enterprise-wide data.

Legato NetWorker Module for Microsoft Exchange Server
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Using NetWorker Software to Protect your Network

Using NetWorker Software to Protect your Network

Legato NetWorker software is a high-capacity, easy-to-use management
solution for network data storage that provides data backup and recovery for
heterogeneous networks of servers and clients. Using NetWorker software to
protect your network simplifies the storage management process and reduces
administrative burden by automating and centralizing your data storage
operations.

With NetWorker, you can:

® Perform automated “lights-out” backups during off-peak hours

e Use centralized administration to configure, monitor, and control
backups from anywhere on a network

e Automate tape handling tasks using SmartMedia®, the intelligent media
manager that Legato provides

* Increase backup performance by simultaneously sending data from
multiple clients to the storage management server

® Use concurrent device support to direct data streams to multiple backup
devices for even greater speed

® Clone backup media for local and off-site storage strategies

Using NetWorker Module to Protect your Exchange Servers

The NetWorker Module software is an add-on module for NetWorker
software. It provides automated storage management for Microsoft Exchange
Server databases. A filesystem backup does not save your Microsoft Exchange
Server data in recoverable form. To be able to recover Exchange Server objects
such as storage groups, databases and mailboxes, you must back up the data
using one of the methods described in this guide.

How NetWorker Module and NetWorker Work Together

The Microsoft Exchange Server software can reside on the same system as the
NetWorker server software, or on a separate system. However, NetWorker
Module software must be installed on the same system as the Microsoft
Exchange Server and the NetWorker client software. In addition, the Microsoft
Exchange Server host computer must be configured as a storage management
client of the NetWorker server. For details about NetWorker and NetWorker
Module configuration, refer to the Legato NetWorker Administrator’s Guide.
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Chapter 1: Introduction

Client-Server Model

NetWorker uses a client-server model to provide storage management
services. This means that at least one computer on the network is designated
as a NetWorker server. Computers with data to back up are configured as
clients of the NetWorker server.

The NetWorker server:

* maintains resource information

* contacts clients listed in backup groups configured on the server
e performs manual backups when a client request is received

¢ restores data upon request from the client

* maintains the online client file index

e maintains the media database

Backup Process

When a scheduled backup for a Microsoft Exchange Server client is triggered
by nsrd on the NetWorker server, savegrp executes the NetWorker Module
backup command (nsrxchsv) on the client instead of performing a standard
save. The nsrxchsv.exe program sends the backup data received from
Microsoft Exchange Server to NetWorker through an X-Open® Backup
Services Application Programming Interface (XBSA). The final results of the
savegrp execution are sent back to the server and are included in the
savegroup completion report, which is sent according to the notification set up
in NetWorker Administrator for the Savegroup event.

The NetWorker software performs the scheduling and storage management
tasks. The NetWorker Module software passes the data from Microsoft
Exchange Server to NetWorker. Figure 1 on page 20 shows the functional
relationship between NetWorker, NetWorker Module, and Microsoft
Exchange Server, during a scheduled backup.

Legato NetWorker Module for Microsoft Exchange Server
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Restore Process

Figure 1. NetWorker Client-Server Interaction
During a Backup Initiated by NetWorker Module
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Restore Process

When a restore request is initiated by the NetWorker Module version of the
recover command, nsrxchrc, the NetWorker XBSA API translates the object
names requested by the NetWorker Module into a format understood by the
NetWorker software and forwards them to the NetWorker server’s nsrd
service. The media service, nsrmmd, invokes nsrmmdbd to search the
NetWorker server’s online media database for the media containing the
object(s) requested.

After the media is mounted, nsrmmd sends the data through the NetWorker
XBSA API to nsrxchre, which recovers the data to the Microsoft Exchange
Server directories.
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Figure 2 shows how data moves from the NetWorker server to the Exchange
server during a NetWorker Module restore session.

Figure 2. NetWorker Client-Server Interaction
During a Recovery Initiated by NetWorker Module
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Chapter 2: Backup Types and Levels

This chapter introduces basic concepts for backup and recovery of Microsoft

Exchange 2000 Server.

Overview of Backup Types and Levels

The NetWorker Module supports four backup levels and two backup types.
Table 1 shows the backup levels that are supported for each backup type.

Table 1. Backup Levels Available for Scheduled and Manual Backups

Backup Type
Backup Levels Scheduled Manual
Full yes yes
Copy no yes
Incremental yes yes
Differential yes yes

Legato NetWorker Module for Microsoft Exchange Server
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How Scheduled Backups are Processed

How Scheduled Backups are Processed

A scheduled backup is one that starts automatically at a preset time. The
NetWorker server initiates scheduled backups.

The NetWorker server starts a separate backup process for each item specified
in the save set list. For example, if MSEXCH:IS is specified in the save set list
on the NetWorker server, the server starts one process on the client to perform
a backup of the entire Exchange Server Information Store.

If multiple items are specified in the save set list, the server starts multiple
processes on the client machine. This provides support for parallel processing
of storage groups. For example, selecting storage groups 1 and 2 for backup
(save sets MSEXCH:IS/SGland MSEXCH:IS/SG2) causes the server to start
two backup processes in parallel: one for each storage group. This feature
allows you to back up all the storage groups on your Exchange server in
parallel.

Note: You cannot back up multiple databases within the same storage group
in parallel.

How Manual Backups are Processed

A manual backup is one that you start yourself from the NetWorker client host,
using the NetWorker Module GUI (“NetWorker User for Exchange Server”), or
using the command line interface. You can back up as few or as many items as
you like. Items marked for backup are processed sequentially when the
backup is started manually.
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Selecting Exchange Server Objects for Backup

Table 2 on page 25 explains what to mark in NetWorker Module, to back up
Exchange Server objects.

Table 2. What is Marked - What is Backed Up

What is Marked

What is Backed Up

Information Store

All storage groups on the Exchange server.

Storage Group

All databases in the storage group.

Database

Only the database that is marked.

Private Mailboxes

All mailboxes.

Mailbox

Only the marked mailboxes.

What is Backed Up at Each Level

In NetWorker Module, four backup levels are available: full, copy, incremental
and differential. What each level backs up is explained in
“Backup Levels - List”.

Note: In the NetWorker software, the Differential level has nine sub-levels. In
the NetWorker Module software, Differential backups are performed at level 1
only.

Backup Levels - List

Full (database and logs; truncate committed logs) - Backs up databases
and associated transaction logs. Once the databases and transaction logs
are backed up, the transaction logs are truncated. It is recommended that
you perform full backups daily to prevent log files from monopolizing
space on the hard disk. A full backup must be performed on all databases
within a storage group before an incremental or differential backup is
allowed.

Copy (databases and logs) - Makes a full backup of the Microsoft
Exchange Server without disturbing the state of ongoing incremental or
differential backups. This level of backup is like a Full backup, except that
the transaction logs are not truncated after being backed up.

Legato NetWorker Module for Microsoft Exchange Server
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Setting Backup Levels

¢ Incremental (logs) - Backs up only the Exchange transaction logs and
then truncates them. To restore from incremental backups, the required
backups include all incremental backups done since the last full backup
and the full backup itself.

¢ Differential (logs) - Backs up only Microsoft Exchange’s transaction logs,
but unlike the incremental level, it does not truncate them. To restore from
differential backups, one differential backup and the original full backup
are required.

Note: Incremental and Differential backups are not permitted by
Exchange 2000 Server if circular logging is enabled. For information about
disabling circular logging, refer to Microsoft Exchange Server
documentation.

Setting Backup Levels

When you use the NetWorker Administrator program to schedule a regular
backup and set the backup level, the backup level setting is retained until you
change it. The level can depend on the selected schedule, for example, “Weekly
Full.”

For manual backups, the level you set applies to the next backup that you
perform.

Scheduled Backups
Set the backup levels for scheduled backups as follows:

1. Open the NetWorker Administrator software. In the Configure tab, under
the heading NetWorker Groups, click the Manage Groups button.

2. Right-click on the Exchange Server for which you want to set or select
backup levels, and select Edit from the submenu.

3. Set the level if you always want to use the same backup level, or set the
schedule to allow the schedule to determine the level.

Scheduled backups support three of the four possible levels in NetWorker
Module: full, incremental or differential (level 1 only).
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Manual Backups

For manual backups that you initiate from NetWorker User for Exchange
Server on the NetWorker client host, specify backup levels in the Backup
Options dialog box:

1. Open the Backup window.

2. From the Options menu, select Backup Options. The Backup Options
dialog box opens.

3. Under Backup Level, click on the circle beside the backup level you want,
to select it.

For manual backups that you initiate from a Windows command prompt on
the NetWorker client host (by entering commands on the command line), you
can also specify the four main backup levels: full, copy, incremental, and
differential (level 1 only). For detailed instructions on using NetWorker and
NetWorker Module software from the command line, see

“Appendix A: Commands, Command Options and Save Sets” on page 99.

Table 3 on page 27 shows how the available backup levels are modified
according to whether you are backing up automatically or manually. It also
shows how the backup level is affected by the interface that is used to initiate
the backup.

Table 3. Backup Type and Level Modifications

Backup Levels Available

Operation Initiate from Full Copy Differential  Incremental)
NetWorker Yes No Yes Yes

Scheduled Administrator

backup (server GUI)
NetWorker client host | Yes Yes Yes Yes
command line

Manual NetWorker User for | Yes Yes Yes Yes

backup or Exchange Server

Recovery (client GUI)

Legato NetWorker Module for Microsoft Exchange Server
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Backup Level Notation in Media Database

For any backup that was performed, you can check the level in the Volumes
tab or the Indexes tab in the NetWorker Administrator software. Table 4 shows
the notation used for each backup level.

Table 4. Media Index Entries for Backup Levels

Corresponding Parameter Backup Level Recorded
for in NetWorker Media
Backup Level nsrxchsv -l Option Database
Full -l full full
Copy none none
Incremental -lincr inc
Differential -l diff diff
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This chapter describes how to use NetWorker software in combination with
NetWorker Module software to implement scheduled, regular backups of
your network’s Exchange Servers. For complete information on using the
NetWorker Administrator program, refer to the Legato NetWorker
Administrator’s Guide.

Note: Once you complete the installation process, you must enable, register,
and authorize your NetWorker products. If you enable a NetWorker product
but do not properly register the software, it will automatically be disabled 45
days from the date it was enabled.

You can register NetWorker either online through the World Wide Web, or by
printing your registration information using the NetWorker Admininstrator
program, and then faxing the printout to Legato.

For complete information on enabling, registering and authorizing your
NetWorker Module software, see the Legato NetWorker Module for Microsoft
Exchange Server Installation Guide.

Planning Backups

Automatic, scheduled backups are the NetWorker Module software's primary
means of protecting your data. Only scheduled backups ensure that all of your
Exchange Server data is automatically saved. Manual backups do not
automatically include the client file indexes and bootstrap file. These are vital
for restoring the Exchange servers, in the event of a disaster. Because each
scheduled backup automatically includes these files, it is important to make
sure that scheduled backups are performed regularly.

Legato NetWorker Module for Microsoft Exchange Server
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Multiple Databases

In previous versions of Microsoft Exchange Server, the Information Store
supported only one private messaging database (Priv.edb) and one public
messaging database (Pub.edb) per server. If either of the two databases grew
too large, it could be time-consuming to back it up or restore it.

In Microsoft Exchange 2000 Server, storage groups can contain one or more
databases - that is, Exchange Server now supports multiple databases on each
server. By providing separate databases for public folders and private
mailboxes, Exchange 2000 Server makes it easier to manipulate, back up, and
restore the databases.

Two databases in Exchange 2000 Server have special names and functions.
They are the Key Management Server and Site Replication Server. For the
purposes of backup and recovery, these are treated identically to any other
Exchange Server database. For convenience, they are often put into one
backup group.

To balance network activity, consider setting up the following backup groups:
* (lient host filesystem data, including Active Directory, System State and
bootstrap protocol files

¢ Exchange Server, Key Management Server (if installed), and Site
Replication Server (if installed)

e Private mailboxes

Planning Backup Schedules

In Microsoft Exchange 2000 Server, public information and messages reside in
the Information Store. To maximize space and enhance performance on the
Exchange Server, the Information Store is structured for single-instance storage
within each database. For example, if a 1 MB message is sent to 100 users in the
same database, only one instance of the message is stored on the Exchange
server. Pointers to the message body and attachments are placed in each user's
mailbox. Therefore the message uses only 1 MB of disk space, and only 1 MB
is backed up. This design is optimal for efficient, reliable, storage on the server;
however, it is not ideal for recovering a user’s mailbox, folder, or message,
primarily because the data is not organized from a mailbox-backup
perspective.
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Private Mailboxes

Backing up a user’s mailbox extracts all message components from the
database. This includes message body, header, and attachments. As a result,
backing up a large number of individual mailboxes can take much longer, and
require more free disk space, than backing up the Information Store or any
other Exchange database.

Consider these factors:

* Mailbox backup is not recommended for large numbers of individual
mailboxes, because backing up individual mailboxes takes significantly
more time than backing up an Information Store.

e Private mailbox backup can be performed only at level Full, not at the
Incremental or Differential levels. This contributes to time required for
private mailbox backup operations, but is necessary to ensure reliable
data recovery.

¢ In the event of a disaster, the Information Store cannot be rebuilt by
recovering the private mailboxes, but it is possible to recover individual
databases from a storage group backup. Regularly scheduled database
backups using Legato NetWorker and NetWorker Module for Exchange
Server software is the best choice for disaster recovery.

¢ For information about the process for backup of private mailboxes, see
“Backing Up Private Mailboxes” on page 34.

Improving Performance

To improve performance of backups of the Exchange Server:

* Set backups for private mailboxes at separate times from backups of the
Information Store. Even when they are in different backup groups,
network congestion may result from performing these backups
simultaneously.

e Itis useful to set start times for different backup groups far enough apart
that each backup operation can finish before the next backup operation
starts.

¢ Setscheduled backups for times when the network is less busy, for
example, nights and weekends.

* Do not use NetWorker Client to back up the Exchange Installable File
System. For detailed information about this, see “Excluding the Exchange
Installable File System from Backup Operations” on page 32.

Legato NetWorker Module for Microsoft Exchange Server
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Excluding the Exchange Installable File System from Backup Operations

The Exchange Installable File System (EXIFS) is a new feature in Exchange 2000
Server. ExIFS allows file level access to various items within a private or public
information store. The ExIFS is displayed as a disk drive, using the drive letter
M:. Users can access the web storage system using Windows Explorer, Internet
Explorer, or other mechanisms supported by Windows 2000.

A scheduled file system backup will attempt to back up files on the M: drive.
This will not be successful because the Information Store will have many of the
files open. It is also not possible to restore the Exchange Server databases by
recovering a backup of the EXIFS. For this reason most users will choose to skip
the file system backup of ExIFS. This can be done easily by creating a custom
directive.

How to Create a Custom Directive

To create a custom directive to skip the file system backup of ExIFS:
1. Create a new directive using the NetWorker Administrator program.
2. Enter a name for the new directive.
3. Enter the following commands in the Directive field:
<<"M:" >>
skip: *.*

4. Edit the client resource that is used for the file system backup of the
Exchange server. Select the name of your custom directive to skip the file
system backup of the ExIFS drive.

5. Figure 3 on page 33 shows an example of a directive for skipping the ExIFS
file system backup.
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Figure 3. Directive to Skip File System Backup
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Creating and Configuring Backup Groups

Each Exchange Server host must be configured as a NetWorker client using a
Client resource in NetWorker Administrator. The Client resource provides the
NetWorker server with information about the following:

* What data to back up for a client.

¢ How long to maintain entries for the data in the online index for recovery

(browse policy).

¢ How long to keep the media containing the client’s backed-up data

(retention policy).

After your NetWorker Module software is installed and enabled (for detailed
information, see the Legato NetWorker Module for Microsoft Exchange Server
Installation Guide), there are two main steps for configuring Exchange servers

as NetWorker clients:

* Create a backup group resource in NetWorker Administrator for
scheduled backups of Exchange Server (see “Task 1: Configure Backup
Groups” on page 36).

e Create a client resource in NetWorker Administrator for the Exchange
Server on which you installed the NetWorker Module for Exchange
Server software (see “Task 2: Configure Clients” on page 37).

Legato NetWorker Module for Microsoft Exchange Server
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Backing Up Private Mailboxes

With NetWorker Module for Microsoft Exchange Server, you can back up and
recover private user mailboxes. Because the way that you set up mailbox
backups affects the ways you can restore them, information about restoring
mailboxes is included here.

The processes for backing up and restoring mailboxes involves the following:

* During a mailbox backup, the contents of the specified mailbox are
copied from the information store to a temporary file. The temporary file
is saved to the NetWorker server and entered in the NetWorker index
database. When the backup is complete, the temporary file is deleted.
This process is repeated for each mailbox being
backed up. The Exchange Server must have sufficient free space to
accommodate the temporary file.

* During a mailbox restore, the latest backup of the mailbox prior to the
recovery browse time is identified in the NetWorker index database and
restored from the NetWorker server to a temporary file. The contents of
the temporary file are copied to the Exchange information store. When
the recovery is complete, the temporary file is deleted. The contents of
the mailbox are recovered to a folder called “Recovered Items,” in the
same mailbox as they were backup up from. The hierarchy of folders and
messages present in the original mailbox is preserved in the Recovered
Items.

Mailbox Backup Requirements
The following is the list of requirements for backup and recovery of mailboxes:
¢ The user must be logged in on the Exchange server as a member of the
Administrators group, with the following permissions:
¢ List Contents
¢ Read Properties
e Administer Information Store
® View Information Store Status

e Receive As
e Send As

Legato NetWorker Module for Microsoft Exchange Server
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Customizing Backup Group Parameters

NetWorker provides a preconfigured group named “Default.” You can modify
the Default group’s attributes, but you cannot delete Default from the list of
NetWorker groups. The Default group has the following attributes:

* Autostart = Disabled
After you enable the autostart feature, clients in a backup group start
their scheduled backups at a designated time. Be sure to enable the
Autostart option for the configured groups; otherwise, the scheduled
backups cannot take place.

e Start time = 3:33

e C(Client retries =0

¢ Clones = No

* Clone pool = Default Clone

Using Browse and Retention Policies

To manage and reduce the size of online indexes, the NetWorker software uses
browse policies for the client index entries and retention policies for the media
database entries. You can choose one of the preconfigured policies provided
with NetWorker or create policies of your own.

NetWorker does not allow a backup group’s browse policy to exceed that
group’s retention policy. The entry for a save set must be removed from the file
index before the save set can be removed or marked recyclable in the media
index.

You can manage the indexes manually by means of the Indexes and Volumes
windows. Refer to the Legato NetWorker Administrator’s Guide for a description
of manual index management and index policy concepts.

For information on how to set the browse and retention policies, see “How to
Select Schedule, Browse policy, and Retention Policy” on page 41.

Legato NetWorker Module for Microsoft Exchange Server
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Implementing Scheduled Backups

This section explains how to start scheduled backups of the Information Store,
Key Management Server (if installed) and Site Replication Server (if installed).
Perform the steps in this section in the NetWorker Administrator program. For
a detailed description of each text box in the NetWorker Administrator
software’s dialog boxes, click the Field Help button at the bottom of the box.

This section contains detailed instructions for each of the major tasks in
implementing scheduled backups of the Exchange Server. The major tasks are:

“Task 1: Configure Backup Groups” on page 36
“Task 2: Configure Clients” on page 37
“Task 3: Enter Remote Access Accounts and Users” on page 42

“Task 4: Test the Configuration” on page 43

Task 1: Configure Backup Groups

To set up backup groups:

1. Intheleft-hand pane of the NetWorker Administrator, select the Exchange
server that you want to back up. In the right-hand pane, select
Configure>Manage Groups.

2. Inthe Groups dialog box, right-click on the main Groups icon and from the
submenu that appears, select Create.

3. In the Create Group dialog box that opens, enter a name in the Name box.
4. In the Autostart box, select Enabled.

5. Use the up or down arrow to set the number of Client retries.

Legato NetWorker Module for Microsoft Exchange Server
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6. Set the backup level in the Level box, or select a schedule with the levels
that you want in the Schedule box.

a. If the Level and Schedule boxes are not visible, close the Create
Group dialog box.

b. In NetWorker Administrator, open the Options menu, select
Customize, and click the Window Configurations tab.

c. Select the Display Hidden Attributes option.
d. Click Ok to save your setting and exit.

e. Re-open the Create Group dialog box. The Level and Schedule text
boxes are visible. Select the level you want.

7. Select Ok to save settings and exit.

Task 2: Configure Clients

Perform this task in the NetWorker Administrator program:
1. In the Configure tab, select Manage Clients.

2. Right-click on the server for the group you created, and select Edit from
the submenu.

3. In the Edit Client dialog box, in the Group text field, select the group you
created.

4. In the Save set box, enter the save set specifications for the Microsoft
Exchange Server objects you want to back up (see Figure 4).
Use the save set specifications listed in:

® “Save Set Specifications for Storage Groups and Databases” on page
38.

® “Save Set Specifications for Private Mailboxes” on page 40.

Legato NetWorker Module for Microsoft Exchange Server
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Save Set Specifications for Storage Groups and Databases

To configure save set specifications for storage groups and databases, in the
NetWorker Administrator Edit Client dialog box (see Figure 4 on page 39 for
examples of entering Information Store and database save set specifications):

To specify a backup of all the backup-enabled Exchange applications
(currently IS, KMS, SRS; but not “All private mailboxes”), enter:

MSEXCH:

To specify a backup of the entire Information Store, enter:
MSEXCH:IS

To specify a backup of a Storage Group, enter:
MSEXCH:IS<storage_group>

To specify a backup of the Key Management Server (if installed),
enter:

MSEXCH:KMS

To specify a backup of the Site Replication Server (if installed), enter:
MSEXCH:SRS

To specify a backup of all user mailboxes, enter:

MSEXCH:MB

38
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Figure 4. Information Store and Database Save Sets

Edit Client anchorage.com Ed

Cliert Infarmation I Pratacal | Mizcelaneous
General | Preferences | Femate

Mame: Ianchurage.id.legatn.cnm

Save set [ SExCH:IS
MSEHXCH:KMS
MSEXCH:SRS

N I

% Growe [ Detanit

Schedule: IDEfau“

Kl

Directive: | 1005 standard directives -

[C]D0S with compression directives =

Browvese policy: IMDnth

L Lo

Retention policy: I“r’ear

oK, - Field Help | Help

Notes

e Previous versions of the software (previous product name: Legato
BusinesSuite Module for Microsoft Exchange Server) always performed a
full backup when MSEXCH: was used. In NetWorker Module for
Exchange Server, Release 3.0, the level specified in the group schedule is
the level used.

* The save set MSEXCH:DS is obsolete in Release 3.0, because Exchange
2000 Server does not have its own directory.
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A

Important: Do not use the Save set All. This is a NetWorker save set, not a valid
NetWorker Module save set. Using it results in a backup of the entire file
system except for Exchange Server objects.

Save Set Specifications for Private Mailboxes

To configure save set specifications for backing up private mailboxes, open the
NetWorker Administrator Edit Client dialog box.

See Figure 5 on page 41 for examples of entering private mailbox save set
specifications.

For further information on save set specifications, see

“Appendix A: Commands, Command Options and Save Sets” on page 99):

To specify a backup of one private mailbox, enter:
MSEXCH:MB / <mailbox_name>

To specify a a backup of multiple private mailboxes, enter a
specification for each mailbox on separate lines, without quotation
marks, as shown in Figure 5 on page 41.

Enter:

MSEXCH:MB / <mailbox_name>

MSEXCH:MB / <mailbox_name>

MSEXCH:MB / <mailbox_name>

To schedule backups for many individual user mailboxes without
backing up the entire private mailbox database, use the -I I<Input_file>

command option. See “How to Use an Input File to Specify Multiple
Private Mailboxes for Backup” on page 43.

40
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Figure 5. Private Mailbox Save Sets
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How to Select Schedule, Browse policy, and Retention Policy
To set the schedule, browse policy, and retention policy:

1. In the NetWorker Administrator Edit Client dialog box, click the
drop-down list to choose from the pre-configured schedules in the
Schedule box.

2. In the Browse policy box, click the drop-down list to select the browse
retention period.

3. In the Retention policy box, click the drop-down list to select the browse
retention policy period.
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Task 3: Enter Remote Access Accounts and Users

1. Select the Remote tab of the Edit client dialog box.

2. Inthe Remote Access text box, enter the names of users and hosts who will
back up client files, as follows:

In the Backup Command text box, type the NetWorker Module backup
command and the command options that you need. Enter:

nsrxchsv.exe

Figure 6. Enter Remote Access Accounts and Users
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Task 4: Test the Configuration

Test the configuration by using the “Group Control” feature in the NetWorker
Administrator GUI to start the backup, or verify that the first automatic
backup was successful after it runs at the first scheduled time. Refer to the
Legato NetWorker Administrator’s Guide for instructions on using the Group
Control feature.

Note: Write the results of a scheduled backup to a log file by entering the
following in the Notifications dialog box: nsrlog -f filename. Refer to the Legato
NetWorker Administrator’s Guide for details on using the NetWorker
administration program to customize your notifications.

How to Use an Input File to Specify Multiple Private Mailboxes for Backup

To schedule a backup for multiple mailboxes without backing up the whole
mailboxes database, create and save an Input file.

¢ Enter the -| <input-file> option in the Backup Command text box in
NetWorker Administrator. The -| <input-file> option reads the mailbox
names to be backed up from the Input file.

¢ To add or remove individual mailbox names, you can edit the Input file.
To back up multiple private mailboxes, perform these tasks:

e “Task 1: Create an Input File” on page 44

e “Task 2: Configure a NetWorker Backup Group” on page 44

e “Task 3: Create a Client Resource for the Exchange Server” on page 44
e “Task 4: Start the Exchange Backup Group” on page 46
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Task 1: Create an Input File
Create an input file as follows:

1. Use any text editor to create an input file in DOS .txt format. Enter the
names of the mailboxes that you want to back up on separate lines, without
quotation marks, as shown in Figure 7:

Figure 7. Mailbox Names in Input File
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2. Save the input file to the default directory, which is the installation
executable path specified on the NetWorker client: \nsr\bin.

Task 2: Configure a NetWorker Backup Group
Edit the Group resource as follows:

1. From the Edit Group dialog box, click the General tab, and enable the
Autostart option for the group.

2. In the Backup Level field, enter Full for the backup level. (Only full
backups are supported.)

3. In the Activity Timeout field, specify a large number (for example, more
than 300).

4. In the Schedule field, choose a schedule or create one of your own.

Task 3: Create a Client Resource for the Exchange Server
Edit the Client resource as follows:

1. From the Create/Edit Client dialog box, select the General tab, and in the
Save set text box, enter MSEXCH:MB.

Legato NetWorker Module for Microsoft Exchange Server
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2. In the Remote tab of the Edit Client dialog box:

a. Enter the names of users and hosts who will be allowed to back up
client files in the Remote Access text box.

b. If the \nsr\bin file is in the default directory (<install path>:\nsr\bin),
enter the backup command, the command option, and the name of
the input file in the Backup Command text box:

nsrxchsv.exe -I <Input_file>

c. If the input file is located in a directory other than the default, enter
the backup command, the command option, and the full path to the
file, using quotation marks and double backslashes as shown in
Figure 8:

nsrxchsv.exe -1 “C:\\my_folder\\input_file.txt”
Figure 8. Entering Input File Option
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Task 4: Start the Exchange Backup Group
Start the Exchange Backup Group by:

¢ Using the NetWorker Administrator software’s “Group Control” feature.
¢ Allowing the next scheduled backup to run at the preset time.

For instructions on using the “Group Control” feature, refer to the Legato
NetWorker Administrator’s Guide for your NetWorker software.

Planning Backup Storage

NetWorker provides a means for directing your backups to specific sets of data
storage media.

Using Volume Pools

Using volume pools allows you to establish a logical and systematic method
for tracking, organizing, and sorting your backup data. Volume pools are
always associated with a label template. The label template provides an
automated method of identifying media assigned to a pool.

What is a Volume Pool

A volume pool is a collection of labeled media volumes containing specified
data from a NetWorker backup. To help organize your storage management,
you can direct related data to the same pool. Volume pools provide the ability
to segregate backed-up data, such as information in a database, transaction
logs, and files. Pools also allow you to direct backup data to specific devices.

The NetWorker software writes data to labeled volumes associated with a
specific volume pool you specify. All NetWorker volumes belong to either a
preconfigured pool or a pool you create. If you do not assign data to a specific
pool of volumes, NetWorker automatically uses the Default pool and looks for
volumes with the pool label “Default.”

Each NetWorker server has a Pools resource.

Legato NetWorker Module for Microsoft Exchange Server
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How to Create a New Volume Pool
To create a new pool:
1. Click Manage Pools in the Configure tab to open the Pools window.

2. Right-click on the main Pools icon, and select Create from the pop-up
menu to open the Create Pool dialog box.

For further instructions on creating pools, refer to the Legato NetWorker
Administrator’s Guide for your NetWorker software.

Volume Pool Locations and Contents

NetWorker uses the choices you select to sort backed-up data to specific
backup volumes labeled for the pool. You can sort NetWorker backup data by
several categories:

*  Object type

e Backup group

* NetWorker client
* Saveset

¢ Backup level

Each pool has a “Pool type” designation, which tells NetWorker whether the
volume contains data that has been archived, backed up, or migrated. For the
NetWorker Module for Exchange Server, the only valid pool types are
“Backup” and “Backup clone.”

The NetWorker Module software directs full backups to a NetWorker data pool,
and directs incremental and differential backups to a NetWorker log pool. You
can specify different data pools and log pools for different NetWorker backup
groups.

The NetWorker Module software only sends transaction log backups to
separate media for incremental or differential backups. The first backup of a
database is always performed as a level “full,” with all backed-up files directed
to the media labeled for the MSXData pool.

For more information about using NetWorker volume pools, see the Legato
NetWorker Administrator’s Guide.

Legato NetWorker Module for Microsoft Exchange Server
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Customizing Volume Pools

This section explains how to customize volume pools for the NetWorker
Module in NetWorker Administrator. You set the volume pool names in the
NetWorker Administrator’s Pools resource. A valid volume pool name is any
valid NetWorker name of 1024 characters or less. At least one volume must be
labeled for each pool.

For more information about using NetWorker volume pools, see the section on
device and media management in the Legato NetWorker Administrator’s Guide.

How to Customize Volume Pools

Use the NetWorker Administrator to customize volume pools and label
templates in NetWorker Administrator for separating data and transaction log
backups:

1.

Create a data volume pool, following the instructions provided in the
Legato NetWorker Administrator’s Guide. For example, specify

“MSXData” as the entry for Name. Select a backup group that is unique for
Microsoft Exchange Server as the choice for Groups. Specify “full” as the
selection for Levels and select “Yes” as the choice for Store Index Entries in
the Preferences tab of the Create Pool dialog box.

. Save the Pool configuration.

A dialog box appears, asking you to select a label template or apply the
configuration again to automatically create and select a label template.

Click OK and reapply the configuration to automatically create a label
template named “MSXData” and assign it to the MSXData pool
configuration.

. Create a log volume pool. For example, use “MSXData” as the entry for

Name and select the backup group you customized as the choice for
Groups. Specify “incr” and “1” as the selection for Levels. Before saving
the configuration, ensure that “Yes” is highlighted as the choice for Store
Index Entries.

Save the Pool configuration.

A dialog box appears, asking you to select a label template or apply the
configuration again to automatically create and select a label template.

Note: The first backup of a database is always performed as a level full,
with all backed-up files directed to the media labeled for the data pool,
which is “MSXData” in this example. The NetWorker Module software
sends both differential and incremental backups to the log pool.
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6. Click OK and reapply the configuration to automatically create a label

template named MSXELogs and assign it to the MSXELogs configuration.

Insert new media, or select another drive or slot with media loaded for
labeling.

Click the Label toolbar button to label media, selecting the label template
customized for the MSXData pool. Repeat the process to label media for
the MSXELogs pool, selecting the label template customized for the pool.

Viewing Backup Results

NetWorker provides several reports about the results of a backup:

A series of messages written to the NetWorker Module for Exchange
Server log files on the Exchange Server host (nsr\applogs\nsrxchsv.log).

A scrolling list of messages displayed in the Group Control window of
the NetWorker administration program.

These messages are displayed in three lists: pending save sets, completed
save sets, and failed save sets.

A “savegroup completion” notice upon completion of a scheduled
backup.

Important: When one or more individual databases in a storage group are
selected for backup in NetWorker User, the save set name that is assigned to
the backup in the NetWorker index is the name of the storage group that holds
the databases. For example, if you perform a backup that consists of
MSEXCH:IS/SG1/DB1, MSEXCH:IS/SG1/DB2 and MSEXCH:IS/SG2/DB3,
you see two save sets in the index, named MSEXCH:IS/SGland MSEXCH:IS/SG2
If you specify the backup operation at a higher level (MSEXCH: or
MSEXCH:IS) when you perform the backup operation, the higher-level name
is assigned as the save set name.
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Setting up E-mail Notification of Backup Results

If you are using a NetWorker server for UNIX, you can send an e-mail
notification of the results of a scheduled backup to the owner of a save set.

1. Use the “View Details” option to edit the NetWorker client resource for the
computer running NetWorker Module for Exchange Server.

2. Edit the Owner Notification attribute and enter a notification command
directed to the login ID of the owner.

3. Edit the notification setup for this report using the Customize feature of
the NetWorker administration program. Refer to the section on setting up
event notifications in the Legato NetWorker Administrator’s Guide for details
on using the NetWorker administration program to customize your
notifications.

The Legato NetWorker Administrator’s Guide provides complete details about the
reports generated by NetWorker.
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Backing Up and Restoring

This chapter provides information on performing recovery operations and
manual backups, on the client host. Recoveries and manual backups can be
performed at any time.

Because the way that objects are backed up can affect the ways that they can
be restored, some information about recovering mailboxes is included in
sections about performing backups.

This chapter including the following topics:

e “Manual Backups” on page 51

* “Performing a Manual Backup” on page 52

e “Performing a Data Recovery” on page 58

* “Monitoring Backups and Recoveries” on page 75

You can start backup and restore operations at any time, on the client host.
Make sure that a scheduled backup of the objects you want to back up or

restore is not in progress before performing a manual backup or restore
operation.

Manual Backups

There are two ways to start a manual backup:
® Use the NetWorker User for Exchange Server user interface (see
“Performing a Manual Backup” on page 52).

¢ Use the Windows command line interface (see “Appendix A: Commands,
Command Options and Save Sets” on page 99).
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Performing a Manual Backup

Complete the following tasks to start a manual backup:

“Task 1: Initiate a Manual Backup” on page 52

“Task 2: Select and Mark Objects for Backup (or Recovery)” on page 53
“Task 3: Select Backup Options” on page 54

“Task 4: Perform the Backup Operation” on page 56

Task 1: Initiate a Manual Backup

1. Open the NetWorker User for Exchange Server software. It opens to the
Startup window (Figure 9):

Figure 9. Startup Window
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2. Click the Backup button to open a Backup browse window (or, to perform
a recovery, click on the Restore button to open a Restore window). These
windows show Exchange Server objects (Figure 10).

Figure 10. Backup Window
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¢ The Microsoft Exchange Server folder contains these Exchange Server
objects:

— Information Store

—  Private Mailboxes

- Key Management Server (if installed)
- Site Replication Server (if installed)

Task 2: Select and Mark Obijects for Backup (or Recovery)

The NetWorker User browse windows -- that is, the Backup and Recover
windows -- work identically, and conform with basic Windows structure.
Select and mark items for backup and recover operations as follows:

How to Open and Close Folders
To open and close folders so that you can view their contents:

¢ Double-click the folders or the boxes beside them to expand folders.
* Double-click again to close folders.
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How to Select and Mark Objects

1. Select the Exchange Server object that you want to back up or recover by

clicking on it.

2. Click the Mark button to put a check mark beside the object, or right-click

on the object to mark it. The check mark indicates the object will be
included in the backup or recover operation.

What is Marked; What is Backed Up (or Recovered)

To back up or recover the entire Information Store, mark the Information
Store folder. Marking the Information Store specifies a sequential backup
of all the databases contained in each storage group on the Exchange
Server.

To back up or recover individual databases, open the database folder in
the left-hand side of the browse window, and mark the individual
database in the right-hand pane.

To back up or recover all databases in a storage group, mark the icon(s) in
the left-hand pane of the window. Marking a storage group specifies a
sequential backup of each database contained within the storage group.

To unmark an item, select the item, then click Unmark. If you have a
multi-button mouse, the secondary button (usually the right mouse
button) alternately marks and unmarks files.

Task 3: Select Backup Options

The Backup Options that are available in this dialog box are explained below
Figure 11.
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1. Open the Options menu and select Backup Options to open the dialog box
(Figure 11).

Figure 11. Backup Options Dialog Box
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2. Select the options you want. The available options are:

¢ Compress data - Compress all selected components before saving to

the NetWorker server.

Important: Microsoft does not recommend compressing Exchange Server
components.

¢ Backup level - To ensure reliable data recovery, manual mailbox
backups can be performed only at level full, not at the incremental or
differential levels. To set the level for this backup, click on the circle
beside the level you want.

3. Click Ok to save settings and close the box.
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Task 4: Perform the Backup Operation
When you are finished marking objects and setting the backup options:

1. Click the Start button to start the backup or recovery (see Figure 9 on
page 52).

* The amount of time NetWorker takes for the backup depends on the
amount of data to be transferred, network traffic, server load, and
tape positioning.

Monitor the Backup

® During the backup, NetWorker displays messages for each object
backed up in the Backup Status window, so you can monitor the
progress of your backup.

¢ Figure 12 on page 57 shows the Backup Status window you see when
the backup operation is successful.

e If your backup takes a very long time and no messages appear in the
status window, there might be no backup volume mounted on the
server. Contact your administrator for assistance.

Complete the Backup Process

1. After your backup is finished, close the Backup Status window (Figure 12
on page 57).

* You can cancel the backup at any time by selecting End Backup from
the File menu or by closing the Backup window.

Important: A backup cannot run if there is no media volume mounted at the
NetWorker server or storage node (backup device). Therefore, it is best to have
a labeled media volume mounted in the storage node at all times. The volume
should be labeled for the volume pool where the backup is to be directed. If
there is no volume in the backup device when a scheduled backup is triggered,
no messages will be displayed in the status window and the backup will wait
for operator intervention.
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Figure 12. Backup Status
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Note: For instructions on performing backups within a Microsoft cluster, see
“Backing Up and Recovering within Microsoft Clusters” on page 79.
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Performing a Data Recovery

This section covers the information you need to perform recoveries from your
backups. Before starting a recovery, read the following:

It contains the following topics:

¢ “How to Set the Database Properties to Allow Recoveries” on page 58
“How to Select and Mark Objects for Recovery” on page 60
“How to Select Recover Options” on page 60

“Selecting a Browse Time” on page 61

How to Set the Database Properties to Allow Recoveries

To recover data from an Exchange server database, you must first set the
Exchange Server database properties so that the database can be overwritten
with restored data. Note, however, that for KMS and SRS, this is not necessary.

In the Exchange System Manager window:

1. Right-click on the icon for the Exchange database from which you want to
restore. Select Properties to display the Database Properties dialog box.

2. Select the Database tab. Mark the check box labelled The database can
be overwritten by a restore (see Figure 13 on page 59).
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Figure 13. Database Properties Dialog Box
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How to Select and Mark Objects for Recovery

1. In the NetWorker User for Exchange Server window;, click the Recover
button to open the Recover window.

Figure 14. Recover Window
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2. Open and close folders and mark and unmark objects for recovery. For
detailed instructions, see “ Task 2: Select and Mark Objects for Backup (or
Recovery)” on page 53.

How to Select Recover Options

You can set options in the Recover Options dialog box before you start a
recovery.

1. Select Options>Recover. The Recover Options dialog box appears (see
Figure 15 on page 61).
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Figure 15. Recover Options Dialog Box
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2. Select the recover options you need. For details, see “Recover Options”.

Recover Options

Replay only recovered logs - Using this option causes Exchange to replay only
recovered logs. Existing log files are not replayed.

Use this option to restore a database to the state it was in at the point in time
the backup was performed. If this option is not selected, Exchange will replay
all recovered logs and then it will replay any existing logs. This gives you the
option to restore a database to a point in time, or replay all logs to minimize
the loss of transactions.

Put databases online after restore - Select this option if you want restored
databases to be mounted automatically, when the restore is completed.

Click the box beside this option to unmark it anytime you want to put the
database online manually after recovering data.

Selecting a Browse Time

This section explains how to select a browse time so that you will be able to

recover the version of your Exchange Server data that you want. By using the
NetWorker User Change Browse Time and Show Version tools, you can restore
an Exchange Server object to the state it was in at any time that it was backed

up.
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Browse Time Background

When you select a browse time, you see a directory tree showing backups that
were created at that time.

When you open the Recover window, the browse time is set to the date and
time at which you opened it. As a result, you see the most recent entries for
backed-up objects.

You can browse all the backed-up versions of an object, within the retention
period. For example, if the retention period is one year, you see entries for
objects that were backed up a year ago.

You can change the browse time by using the Change Browse Time tool in the
Options menu.

Versions Background

Using Versions under the Options menu, you can view the history of the
currently selected object, including all the times it was modified and backed
up. Versions are sorted according to backup time (most recent first). These
versions are available for recovery.

When the Versions dialog opens, the current version is selected. Each version
is listed with its size, backup time, and backup volume location. If the backup
volume is currently online, the location specifies the device as well.

Use the Versions dialog box to find a version of your object from an earlier
point in time, and then change your browse time to the backup time of the
version you want to recover. After you change the browse time, you see other
objects that were in existence (and backed up) at the same time as the selected
object or folder.

Exchange Server Background

Recovering Exchange Server objects — that is, storage groups, databases, or
mailboxes — requires recovering several, possibly many, related files. In
addition to the main database files (the .edb and .stm files), transaction logs and
database patch files are required, to make the database consistent.

Backup of Exchange Servers can take several hours because of the size of items
that must be backed up. A full backup takes longer than an incremental or
differential backup. Generally, the backup schedule is set so that a full backup
of each Exchange Server is performed periodically, for example, once a week.
Incremental or Differential backups, are performed more frequently — usually
once a day.
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The NetWorker Module for Exchange Server software (for which NetWorker
User for Exchange Server is your interface) uses the browse time as a reference
point for identifying the files that must be restored to fulfill a recovery request.
When you start a recovery, NetWorker Module searches the client index on the
NetWorker server to find the most recent full backup, with respect to the
browse time. It then restores all the files that are required for recovering the
Exchange Server objects you requested, from the start of that full backup
through the end of the specified browse time.

Optimal Browse Times

Setting the browse time to any time that falls between backup operations is
fine. Do not select a browse time that falls during a backup operation —in other
words, while backup data was being written to the NetWorker server. Browse
times should be set for times between backup operations, to ensure that the
referenced backups are complete.

&8

Example:

This example illustrates how the set of files required for recovering Exchange
Server objects changes according to the browse time that is selected.

The timeline in Figure 1 shows a hypothetical sequence of backups, consisting
of a full backup followed by three incremental backups, and a final full
backup.

Below Figure 1 there is a list of the sets of files required for recovering
Exchange objects to the states they were in at different points along the
timeline.
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Figure 16. Browse

Time Selection
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* Torecover the data backed up during the first full backup (Full 1), select a

browse time in the range BT1 (that
before Incr 1 begins).

is, any point after Full 1 ends, but

e To recover both Full 1 and Incr 1, select a browse time in the range BT 2
(that is, any point after Incr 1 ends, but before Incr 2 begins).

e Ifno browse time is selected, NetWorker Module defaults to the current
time. In Figure 1, this has the effect of selecting Full 2.

Summary - Selecting a Browse Time

Table 5 summarizes the backups that are recovered for each Browse Time

range shown in Figure 16.

Table 5. Effects of Browse Time Selection

Browse Time Selection Range Backup that is Restored

BT 1 Full 1

BT 2 Full1 + Incr 1

BT 3 Full + Incr 1 + Incr 2

BT 4 Full + Incr 1 + Incr 2 + Incr 3
BT 5 Full 2
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How to Change the Browse Time

While you are in the Recover window, you can browse the online index as of
any time in the past. The Change Browse Time option on the View menu
allows you to view the entries for your backed-up files from that point in time.

Check with your administrator to find out how long backups are retained. For
example, if you would like to recover a lost database or mailbox that you
backed up six months ago, you can do so only if backup volumes are retained
for at least six months.

Change the browse time to the date of the backup you need.

When you open the Change Browse Time dialog box it shows the current date
and time. To select the date you want:

1. Select Change Browse Time from the View menu to open the Change
Browse Time dialog box.

2. Select a new date from the calendar, if necessary. Use Previous Month or
Next Month to change from the current month.

3. Enter a new time (for example, 10:28p) and click OK. Valid values are:

e Hours: 12 or under
e  Minutes: under 60

“"_ 1

e “a” foram. or “p” for p.m.

After you change the browse time, the Recover window displays the entries
for the specified time in the past. The new browse time is displayed in the
status bar at the bottom of the Recover window. All objects you mark are
recovered from a backup made at the selected time.

If you select a browse time that is earlier than the first time you backed up a
file, the file index is empty. If you change the browse time to some time in the
future, you see the files as they look at the present moment. If you enter a time
format that NetWorker does not understand, you receive an error message.

Using the Versions Dialog Box

When you open the Recover window, you see the objects available for
recovery as of the date and time you opened the window. You can open the
Versions dialog box to view all the available backups for any one of these
objects. In the box, you can select the version you want, mark it for recovery
and open a Recovery window for the desired browse time, so that you can start
the recover operation.
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Versions Dialog Box Contents

The data displayed in this dialog box pertains to the object that was selected in
the Recover window when the dialog box was opened.

Name -- the name of the selected object.

Size -- the size of the selected object, in kilobytes.

Mod Time -- the time the selected object was last modified.
Backup Time -- the time(s) the object was backed up.
Location -- the object was backed up to this backup volume

Change Browse Time -- changes the browse time to the backup time of the
version currently selected in the Versions dialog box.

Mark -- click to mark the selected object for recovery or verification.

Unmark -- click to unmark a marked object.

How to Use the Versions Dialog Box
To use the Versions dialog box:
1. In NetWorker User, click the Recover toolbar to open the Recover window.

2. Select the object you want. If you highlight multiple items, the last item
selected is the one for which versions will be shown.

3. From the View menu, select Versions. There is a short delay as all the
available backed-up versions of the object are gathered.

4. The Versions dialog box appears. Select the version that you want to
recover, click the Mark button to mark it for recovery, and with the version
still selected, click the Change Browse Time button to open a Recover
window to the correct browse time, with the object marked for recovery.

5. To start the recover operation, click the Start button.

Note: If you do not mark the version of the object that you want to recover

before you click the Change Browse Time button, the Recover window opens
to the desired browse time, with none of the objects in the window marked for
recovery. You can then select and mark the object(s) that you want to recover.
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How to Start a Recovery

To start a recovery operation:

1.

In the NetWorker User for Exchange Server window, click the Recover
button to open the Recover window.

(Optional) Select Change Browse Time from the View menu, or use the
Versions dialog to select a Save set to recover.

In the right pane of the Recover window, select the icon of the item you
want to recover.

Click the Mark button. A check mark appears next to the items you
selected. To unmark an item in the Recover window, click the Unmark
button or right-click on the item.

Recovering Exchange Server Data

An administrator can initiate a recovery at any time, by:

Using the NetWorker User for Exchange Server program.

Entering the appropriate command and options at a Windows command
prompt.

Note: Recoveries cannot be performed from the NetWorker Administrator
program.

Before you perform a recovery, make sure that objects marked for recovery are
not in the process of being backed up.

How to Recover an Exchange Server Object

1.

2.

3.

In the NetWorker User for Exchange Server window, click the Recover
button to open the Recover window.

(Optional) If you want to recover an object from a different point in time,
select Change Browse Time from the View menu.

In the right pane of the Recover window;, select the object you want to
recover.
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4. Click the Mark button. A check mark appears next to the objects you
selected. To unmark an item in the Recover window, click the Unmark
button.

If you have a multibutton mouse, the secondary button (usually the right
mouse button) alternately marks and unmarks files, one file at a time.

5. Click the Start button.

If the backup volume containing your objects is loaded in the device attached
to the NetWorker server, the recovery starts.

If the recover operation does not begin soon, the wrong volume might be
mounted. Contact your administrator for assistance. If necessary, cancel the
recovery by selecting End Recover from the File menu.

When the recovery is complete, NetWorker displays messages in the Recover
Status window.

Note: For instructions on performing recoveries within a Microsoft cluster, see
“Chapter 5: Backing Up and Recovering within Microsoft Clusters” on
page 79.

Recovering the Key Management Server (KMS)

Key Management Server does not provide an automated way to take a
database offline prior to performing a recover. It also requires the user to
provide a password whenever the KMS service is started. For these reasons the
KMS recover process requires more manual steps than the recover process for
Exchange or SRS.

KMS recovery also requires the Active Directory to contain the user accounts
of administrators who were given full permission to manage KMS.

If the Active Directory containing the KMS administrator accounts is lost or
damaged, it must be recovered before you can recover the KMS.

How to Recover the KMS Database
Recover the KMS database as follows:

1. Verify that the required KMS administrator accounts exist in the Active
Directory. Restore the Active Directory if necessary.

2. Stop the KMS service (MSExchangeKMS).

3. When the KMS service is stopped, move any existing KMS files from the
KMS installation folder (KMSDATA) to a temporary folder.
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4. Start the KMS service. Verify that it is ready for a recover operation, by
making sure the application event log shows the following error message:

KMS cannot mount the key database. Either the database is
missing or it is corrupted. The service started, but

Admin/User can not do any operation except restoring the
database from a backup set. After restoring, please stop and
restart the service.

5. Open NetWorker User for Exchange Server. Mark and recover the version
of KMS that you want to recover, and click the Start button to perform the
recover operation.

6. Stop and restart the KMS service following the recovery.

7. Delete the files you saved to the temporary folder.

Recovering the Site Replication Server (SRS)

Recover the SRS, a specialized Exchange Server database, by following the
procedures for recovering any other Exchange Server database. For
instructions, see “How to Recover an Exchange Server Object” on page 67.

Recovering Private Mailboxes

Before you use instructions in this section, check to see if you can recover your
deleted items using the Exchange 2000 Server System Manager and Microsoft
Outlook.

In earlier versions of Microsoft Outlook® and Microsoft Exchange Server
(Outlook 8.03 and Exchange Server 5.5), it was possible to use Exchange Server
to recover Outlook items after their permanent removal from Outlook folders.
In Exchange 2000 Server this feature is improved. Within the retention period
(configurable by the administrator), you can recover entire mailboxes. Refer to
Microsoft documentation for detailed information.

User-Initiated Recovery

If users are having mail delivered to personal folders stored on their client
systems, they are responsible for the recovery. They can recover the the
personal folders and Personal Address Book, if needed, from a local backup or
file server backup if they stored them on a mapped server drive. If they did not
perform any local backups and no file server backups are available, their data
is lost.
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Administrator-Initiated Recovery

If a user’s client configuration keeps messages and other objects in the
Exchange Server Information Store, then you (the Exchange administrator)
have one of two options:

¢ Recover the required database from the Information Store (see
“Performing a Directed Recovery of a Database” on page 72).

* Recover the user mailbox from a mailbox backup (assuming the mailbox
was individually selected for backup). For complete backup information,
refer to “How to Recover Private Mailboxes from a Mailbox Backup”.

If you work primarily with offline folders, you need to log on to your mailbox
on the server to retrieve deleted items. Some items or folders may not be
recoverable because the length of time that deleted items are stored on the
server has expired. The time period for which objects are retained can be set by
the administrator. For public folders, expiration dates take precedence over the
length of time set by the administrator.

How to Recover Private Mailboxes from a Mailbox Backup

In NetWorker Module for Microsoft Exchange Server, you can only select
entire mailboxes for backup or recovery. Individual folders and messages
cannot be individually selected.

The processes involved in the recovery are: the latest backup of the mailbox
prior to the recovery browse time is identified in the NetWorker index
database and restored from the NetWorker server to a temporary file. The
contents of the temporary file are copied to the Exchange information Store.
When the recovery is complete, the temporary file is deleted. The contents of
the mailbox are recovered to a folder called “Recovered Items,” in the same
mailbox as the one that they were in when they were backed up. The hierarchy
of folders and messages present in the original mailbox is preserved in the
Recovered Items.

If you work primarily with offline folders, you need to log on to your mailbox
on the server to retrieve deleted items.

Some items or folders may not be recoverable because the length of time that
deleted items are stored on the server is set by the administrator. For public
folders, expiration dates take precedence over the length of time set by the
administrator.
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To recover individual user mailboxes:

1.

In the NetWorker User for Exchange Server window, click the Recover
button to open the Recover view.

(Optional) If you want to recover a mailbox from a different point in time,
select Change Browse Time from the View menu.

In the right pane of the Recover view, select the mailbox you want to
recover.

Click the Mark button. A check mark appears next to the mailbox you
selected. To unmark an item in the Recover view, click the Unmark button.

If you have a multibutton mouse, the secondary button (usually the right
mouse button) alternately marks and unmarks files, one file at a time.

To begin the recovery, click the Start button.

When the recovery is complete, the contents of the mailbox are recovered
to a folder called “Recovered Items,” in the original mailbox. Inside the
recovery folder, the hierarchy of folders and messages present in the
original mailbox is preserved.

A separate Recovered Items folder is created for each mailbox recover.

Move the recovered items to a different folder.

. When you are finished, delete the Recovered Items folder.
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Performing a Directed Recovery of a Database

The Directed Recover command allows you to recover Exchange Server data
to a new recovery server in case of a problem on the original recovery server.
Use this feature if a system is inoperable, a disk drive has crashed, or a system
has disappeared from the network. You can easily configure the replacement
recovery server by recovering a set of files for it that were backed up from
another existing client.

How to Configure for a Directed Recovery

Before you perform a directed recovery, ensure that the following conditions
are met:

¢ In NetWorker Administrator, you are listed as an administrator in the
Server Setup dialog box.

¢ In NetWorker Administrator, your host name or user@hostname is
entered in the Remote access list of the NetWorker client from which the
data was backed up.

A

Important: You cannot recover an Exchange 5.5 database to an Exchange 2000
server, or vice versa.

How to Start a Directed Recovery

You must manually create a target database on the recovery server if it does
not exist. The name must exactly match the name of the database being
recovered. Set the “database can be overwritten” property.

Follow these steps on the host to which the data is to be recovered:

1. In NetWorker User for Exchange Server, select Directed Recover from the
Operations menu to open the Source Client dialog box.

2. Select the name of the client whose files you are recovering and click OK.
The Destination Client dialog box appears.

3. Select the data you want to recover.
4. Click Start to perform the directed recovery.

For more information about directed recoveries, refer to the Legato NetWorker
Administrator’s Guide.
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Peforming a Directed Recovery of a Private Mailbox from a Database
Backup

You can recover a user's mailbox from a database backup using the Directed
Recover feature in NetWorker User for Exchange Server.

To do this, you must recover the original Microsoft Exchange database to a
new Microsoft Exchange Server host or virtual server. In the following
procedures, production server refers to the original Microsoft Exchange Server
host. The recovery server is the computer or virtual server to which you plan to
recover the user mailbox.

After you recover the user mailbox to the recovery server, you must merge the
recovered mailbox with the user’s mailbox on the original production server.

Prerequisites

To set up the recovery server, configure a Microsoft Exchange Server host
identically to the original Exchange Server host.

Software and Hardware Requirements are as follows:

*  Microsoft Exchange 2000 Server
e Windows 2000

* Software versions and service packs on production and recovery servers
must match.

¢ (Create a target database with a name that exactly matches the database
being recovered.

* Legato NetWorker 6.0
¢ Legato NetWorker Module 3.0 for Microsoft Exchange Server

* Hard disk: Sufficient capacity to accommodate temporary and restored
Exchange Server files (varies with size of databases).

How to Prepare the NetWorker Server for the Directed Recovery
On the NetWorker server host:

1. Start NetWorker Administrator. If a client resource does not already exist,
create one for the recovery server.

2. In the production server’s client resource Remote access attribute, add:
Administrator@<recovery_server_name>

For more information about NetWorker resources and resource attributes, see
the Legato NetWorker Administrator’s Guide.
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How to Recover a Mailbox from a Database Backup

In NetWorker Module for Microsoft Exchange Server, you can only select
entire mailboxes for backup or recovery. Individual folders and messages
cannot be individually selected. If an individual user’s mailbox is accidentally
deleted and purged, it must be recovered from a mailbox database backup.

The scenario for this procedure assumes:

the user’s mailbox was deleted and purged

the user account was not removed from the Active Directory

The procedure is as follows:

1.

Create a victim database on the recovery server. The names of the storage
group and database on the recovery server must exactly match the
original. Set the "database can be overwritten by a restore" property.

Run the NWM Exchange GUI on the recovery server. Select Directed
Recover from the Operations menu. Select the client name for the original
Exchange server.

Mark the database to be recovered and press the Start button.

After the recover is finished run the Exchange System Manager. Make sure
the recovered database is online. Right-click on the database and select
Run Cleanup Agent from the context menu. This will display the mailbox
names with a red mark to indicate that they are not attached to an Active
Directory user.

Select the desired mailbox. Right-click and select Reconnect from the
context menu. Specify the name of an existing Active Directory user
account for the mailbox.

Run the Active Directory Users & Computers application. Right-click on
the user name and select Exchange Tasks from the context menu. Select the
Move Mailbox task and follow the wizard to specify the desired target
server and mailbox store. This will move the mailbox from the database on
the recovery server to the desired production server.
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How to Verify a Recovery

Log on to the recovery server. Use a Windows 2000 account with Exchange
Server permissions.

1. If you did not select the option to restart Microsoft Exchange Server
services after data recovery, restart them now from ( Select Start >
Programs > Administrative Tools (Common) > Services).

2. Verify that the recovered Exchange Server object that you recovered is
present in the Exchange Server System Manager directory tree.

Recovery Recommendations

Recovery recommendations for NetWorker Module for Microsoft Exchange
Server are:

¢ Minimize the number of transaction logs that are backed up by increasing
the frequency of full backups. A full backup is needed when incremental
or differential backups contain more than 50 log files.

¢ Perform test recover operations regularly.

Monitoring Backups and Recoveries

The Windows 2000 Performance Monitor is a tool for measuring the
performance of your own computer or other computers on a network. It
allows you to view the behavior of objects such as processors, memory, cache,
threads, and processes. The Performance Monitor provides charting, alerting,
and reporting capabilities that reflect both current activity and ongoing
logging. You can use the Performance Monitor to monitor NetWorker Module
for Exchange backup and restore operations. Because NetWorker Module for
Exchange Server supports multiple Performance Monitor instances, it is also
possible to monitor parallel operations.

This section explains how to use Windows 2000 to monitor backup and
recovery operations that are in progress.
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Using the Windows Performance Monitor

The Performance Monitor displays the NetWorker Module software in the
Performance object sub-menu when there is a backup or recovery operation
underway.

1. From the Windows Start menu, select Programs >Administrative Tools
>Performance Monitor, to open the Performance Monitor window (Figure
17).

2. From the toolbar in the right-hand window pane, select the + icon to open
the Add Counters dialog box.

In the Select Counters From computer text field, make sure that the correct
server is selected.

3. Open NetWorker User for Exchange and start a backup or recovery, then
return to the Add Counters dialog box.

4. In the Performance Object field, select NetWorker Module for Exchange
Server from the drop-down list.

5. In the Select Counters From list-box, select any of the counters that are
supported for NetWorker Module and click on the Add button.

Supported counters are:

Average Rate -- Average throughput rate for all files in the current
operation

File Bytes -- Number of bytes processed by the current operation

File Count -- Number of Exchange files or mailboxes processed by the
current operation

File Rate -- Throughput rate for the current file

Total Bytes -- Total number of bytes processed during the current
operation

The display reflects the system activity as the backup or recovery
operation proceeds (Figure 17 on page 77).
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Figure 17. Counters for NetWorker Module
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Chapter 5: Backing Up and Recovering
within Microsoft Clusters

NetWorker Module for Microsoft Exchange Server supports Microsoft Cluster
Server (MSCS). This chapter briefly describes how to configure and use Legato
NetWorker 5.7 or later together with NetWorker Module for Microsoft
Exchange Server, within the MSCS environment. To use these instructions, the
reader should be familiar with Microsoft clustering technology. For more
information about MSCS, refer to Microsoft documentation.

Using NetWorker Module in Microsoft Clusters

The procedures for using NetWorker Module in a cluster (on a virtual server)
are similar to those used on a stand-alone Exchange server host. However,
certain configuration procedures should be followed to ensure reliable
backups and to simplify recovery.

In the following instructions, <node_a> and <node_b> represent the names of
the physical nodes, while <virtual_server_name> represents the network name
of the Exchange server running on the virtual node. As you install and
configure NetWorker Module, replace the names shown in the examples with
the appropriate physical node and Exchange virtual server names for your
cluster.

This chapter contains the following sections:

* “Using NetWorker Module in Microsoft Clusters” on page 79
e “Scheduled Backups” on page 80
¢ “Manual Backup within a Microsoft Cluster” on page 82

® “Recovering an Exchange Server Database in a Cluster” on page 87
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Scheduled Backups

To run scheduled backups, see the following procedures:

¢ “How to Configure Scheduled Backups within a Microsoft Cluster” on
page 80

e “How to Schedule a Backup within a Microsoft Cluster” on page 80

How to Configure Scheduled Backups within a Microsoft Cluster

Perform the following installation and configuration procedures to enable the
NetWorker Module software to perform backups and recoveries of Exchange
servers in a cluster.

1. Install the NetWorker client software and the NetWorker Module for
Exchange Server software on the local disk of <node_a> and the local disk
of <node_b>. For detailed instructions about installing the NetWorker
software in a Microsoft Cluster, refer to the Legato NetWorker Installation
Guide, Windows version.

When you install the NetWorker client software, you have the opportunity
to specify the names of the NetWorker server hosts that may be used to
back up the cluster.

a. To modify the list of authorized servers, edit the
<install_path>:\nsr\res\servers file.

b. After editing the file, restart the NetWorker Remote Exec Service.
2. Install the enabler for NetWorker Module on the NetWorker server host.

How to Schedule a Backup within a Microsoft Cluster

In NetWorker Administrator on the NetWorker server host:
1. Create a group resource to perform the Exchange backup.

2. Create a client resource for each physical node and virtual server:
<node_a>, <node_b>, and <virtual_server_name>. If you have more than one
virtual server, create a client resource for each one. There can be as many
as four virtual servers in a cluster.

3. Make sure that the NetWorker Server can get an authoritative DNS reply
for at least one of the names in the client resource alias list. To do this, enter
the following command, where <alias_name> is the name that is listed in
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the alias field of the Preferences Tab on the Client resource. At least one of
the names in this list must get an authoritative DNS reply. The reply is
authoritative when the reply message does not say “non-authoritative.”

Enter:
<system_root>:\nslookup  <alias_name>
4. Edit the client resource for <virtual_server_name>:

In the Edit Client dialog box, click the General tab and enter the save set
value for the type of backup you want. Save set specifications are listed in
Table 8 on page 102.

The command option to enter varies, in this step, according to whether or
not the virtual server name and client names match:

e If the virtual server name and the client names do not match, in the
Remote tab of the Edit Client dialog box, enter the following
command in the Backup command field, on each Exchange client
resource:

nsrxchsv -a <virtual_server_name> -C <client_name>

e If the virtual server and client names match, enter the following
command in the Backup command field:

nsrxchsv -a <virtual_server_name>
5. Edit the Remote access list to include the following literal strings:

<system>@<node_a>
<system>@<node_b>

6. Edit the Group resource for the Exchange backup group. Set the level to
match the desired backup level. Table 6 shows available backup levels:

Table 6. Backup Levels

Backup Level selected Backup Result

Full Full backup

Incr Incremental backup
1 Differential backup

7. Start the group manually, or allow the NetWorker Module for Exchange
Server software to back up the Exchange Server at the next scheduled time.
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8. After the backup operation is finished, use the Networker Administrator
program’s Index tab to verify that the backup was indexed using the
Exchange server’s network name, <virtual_server_name>.

Manual Backup within a Microsoft Cluster

The procedure for starting a manual backup operation within a Microsoft
Cluster is similar to starting a manual backup on a stand-alone Exchange
server host. The only difference is selecting the virtual server to make active,
when the NetWorker User software opens.

This section explains how to select the virtual server to make active, when you
open the NetWorker User for Exchange Server software in a Microsoft cluster.
After the virtual server is selected, perform backups and recoveries just as you
would normally. For detailed instructions on backing up, see “How to Start a
Manual Backup within a Microsoft Cluster” on page 82.

How to Start a Manual Backup within a Microsoft Cluster

Use the NetWorker User for Exchange Server software to start a manual
backup.

1. Open NetWorker User from within a Microsoft Cluster. The Exchange
Servers dialog box opens, and shows a list of the online virtual servers in
the cluster (Figure 18 on page 83).

2. Select the virtual server that should be opened, and then select OK (see
Figure 18 on page 83).
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Figure 18. Exchange Servers Dialog Box
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The NetWorker User for Exchange Server startup window opens
(Figure 19).

Figure 19. Startup Window
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3. To continue, follow the procedures in “Performing a Manual Backup” on
page 52.

How to Change the Virtual Server

To switch to another virtual server at any time:
1. In NetWorker User, close the Backup or Recover window, if either is open.

2. From the Operation menu, click Select Exchange Server to open the
Exchange Servers dialog box.

3. Inthe Exchange Servers dialog box, select the name of the virtual server to
open, and click OK (see Figure 18 on page 83).

How to Start a Manual Backup from a Command Prompt, within a Cluster

Use the Windows command-line interface to start a manual backup of an
Exchange virtual server in a Microsoft cluster as follows:

1. From the Windows command prompt on <node_a> or <node_b>:

a. Enter the nsrxchsv command, with the -a and -c options, and other
command options that you need.
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The -a and -c options identify the Exchange virtual server and the
NetWorker client index.

Save set syntax is shown in Table 8 on page 102. (If you do not enter a
valid save set parameter, the program returns an error message and
the program closes. )

Note: It is not necessary to use both the -a and -c options when the
-a <virtual_server_name> and -c <client_name> are the same.

2. When the backup is complete, use the Index tab in the NetWorker
Administrator to verify that the backup was indexed using
<virtual_server_name>

&8

Example:

This command is an example of one you might use to back up an Exchange
virtual server:

nsrxchsv -s <NetWorker_server> -a  <virtual_server_name> -C  <client_name>
-1 <Backup_level> MSEXCH:IS

Using an Input File for Mailbox Names within a Microsoft Cluster

To use the -I <Input_file> option to list the names of mailboxes to be backed up
on a virtual server in a Microsoft cluster, the client resource must specify a
uniquely named input file for it, and must specify a uniquely named input file
for the other virtual server(s) in the cluster. The input files must be identically
located, in the <install_path>:\nsr\bin directory of each physical node.

The input file can be specified in the NetWorker Administrator program or on
the command line. For detailed instructions about how to create and specify
an input file, see “How to Use an Input File to Specify Multiple Private
Mailboxes for Backup” on page 43, and Table 9 on page 102.
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&8

Example:

1. For node a, create an input file named vserverl1.txt. Place copies of the file in
the \\nsr\bin directory on node a and in the \ \nsr\bin directory on node b.

2. For node b, create an input file named vserver2.txt. Place copies of the file in
the \\nsr\bin directory on node b and in the \ \nsr\bin directory on node a.

3. Edit the client resource for <node_a> by entering:
nsrxchsv.exe -| vserverl.txt
4. Edit the client resource for <node_b> by entering:

nsrxchsv.exe -| vserver2.txt.

Backup Recommendations

To improve post-recovery processing of Exchange databases, minimize the
number of transaction logs that are backed up, by increasing the frequency of
full backups. As a rule of thumb, schedule a full backup whenever incremental
or differential backups contain more than 50 log files.
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Recovering an Exchange Server Database in a Cluster

The procedure for starting a recover operation within a Microsoft Cluster is
similar to starting one on a stand-alone Exchange server host. The only
difference is selecting the virtual server to make active, when the NetWorker
User software opens.

This section explains how to select the virtual server to make active. After the
virtual server is selected, perform backups and recoveries just as you would
normally. For detailed instructions on backing up and restoring, see “Manual
Operations: Backing Up and Restoring” on page 51.

How to Start a Recovery within a Cluster

Use NetWorker User for Exchange Server to start a recovery within a Microsoft
Cluster.

1. When you open NetWorker User for Exchange Server from within a
Microsoft Cluster that has multiple active virtual servers, the Exchange
Servers dialog opens before the Startup window opens. It shows the
virtual servers in the cluster, so that you can select one to work on ( see
Figure 18 on page 83).

2. The NetWorker User for Exchange Server startup window opens (see
Figure 19 on page 84). Now you can perform the recovery as you normally

would, starting with Step 1(see “Performing a Data Recovery” on page
58.)

How to Start a Recovery from a Command Prompt, within a Cluster

When recovering an Exchange Server database that resides on a virtual server,
use the nsrxchrc command, adding the -a and/or -c¢ options to identify the
Exchange virtual server and the NetWorker client, and setting the recover
values required for the virtual server. For details on command line syntax, see
Table 10 on page 105.

To recover an Exchange virtual server:

1. Use the Exchange System Manager to select the following property:
“Database can be overwritten by a restore”.
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2. Ata Windows command prompt, enter the recover command, replacing
the values shown in the example with the values you require:

nsrxchrc -erq -c <client_name>-s  <NetWorker_server_name>
-a  <virtual_server_name> MSEXCH:IS

Note: If the NetWorker client name and the Exchange virtual server name do
not differ, you need not enter both the -a and -c options.

A

Important: After the files are recovered, Exchange Server may require a long
time to replay the transaction logs, depending on your system configuration,
Exchange Server parameters, and the number of logs recovered. You can
monitor transaction log progress with the Windows Event Viewer. The
advisory message indicates “The database engine is replaying log file
exxnnnnn.log 7, where xx is the storage group number starting with 00, and
nnnnn is a five-digit hex number.

Recovery Recommendations

¢ Toimprove post-recovery processing of Exchange databases, minimize
the number of transaction logs that are backed up. You can do this by
increasing the frequency of full backups. For example, schedule a full
backup whenever incremental or differential backups contain more than
50 log files.

* Test your recovery procedures on a regular basis.
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This chapter covers the procedures to follow in case of a catastrophic data loss
- that is, the loss of an Exchange server. It contains the following sections:

e “Prerequisites” on page 89

e “Disaster Recovery” on page 90

Prerequisites

1. Itis strongly recommended that these files always be backed up or
recovered at the same time:
® system partition (c:\), or all disk drives
e SYSTEM STATE
e SYSTEM FILES
e SYSTEM DB

This can be done by specifying the save set All for file system backups.

A

Important:

Failure to back up or recover these components together will yield
unpredictable results.

Back up of the M:\ drive is not required.

2. To complete the backup and recovery operations on the COM+ database,
you must ensure that the TEMP environment variable points to a valid
directory.
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3. NetWorker requires the IIS metabase to be located at
<System_Root>\system32\inetsrv\ MetaBase.bin

4. Abackup of the Active Directory (using save set All) is required whenever
configuration changes are made.

Disaster Recovery

The procedures for recovering an Exchange server consist of the following

tasks:

“Task 1: Reinstall the Operating System” on page 90

“Task 2: Configure the System for Recovery” on page 91

“Task 3: Recover the System to the Pre-disaster State” on page 91

“Task 4: Reinstall Exchange Server software” on page 92

Task 1: Reinstall the Operating System

1. To reinstall the Windows 2000 operating system:

a.
b.

Install to the same disk and partition used previously.

Configure the machine properties to match the original configuration.
This includes computer name, Administrator account name and
password.

Configure the TCP/IP properties to match the original configuration.
This includes IP address, default gateway, subnet mask, and DNS
server.

Set the Date/Time properties to match the original configuration.

Install the computer into a workgroup, not a domain. If the computer
was previously a domain controller or a member of a domain, it will
be restored to the correct domain when recovery is complete.

2. Restart the computer after installing the operating system.
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Task 2: Configure the System for Recovery

To configure the system for recovery:

1.
2.

Reset the virtual memory settings to match the original configuration.

Edit <system_root>\system32\drivers\etc\hosts. For the NetWorker server,
add:

¢ ]P address
¢ Fully qualified domain name

¢ Any aliases that will be used for the recovery
Save and close the file.

Verify network connectivity to the NetWorker Server. To do this, at a
Windows command prompt on the Exchange server, enter:

ping <server_name>)

Reinstall NetWorker Client 5.7 (or later), in the original installation
directory.

Task 3: Recover the System to the Pre-disaster State

1.
2.
3.

Open the NetWorker User program (winworkr —s  <server_name>)
Click the Recover button to open a Recover window.
The following must be selected, marked, and recovered together:

e All disk drives
e SYSTEM STATE
e SYTEM FILES

e SYSTEM DB

In the Options menu, select Recover Options and select Overwrite Existing
File.

Click the Start button. The recovery operation starts.

When the recovery is finished, reboot the system. The system is now
restored to the pre-disaster state.
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Task 4: Reinstall Exchange Server software

To reinstall the Exchange 2000 Server software:
1. Reinstall Exchange 2000 Server from the CD-ROM.
a. Execute Setup.exe/Disaster Recovery

2. The Exchange setup does not create any missing storage group directories.
Verify that all storage group directories exist. If any are missing;:

a. Using Exchange Server System Manager, display the database
properties. The Database tab contains the path to the storage group
files.

b. Manually create any missing storage group directories.

3. In Exchange Server System Manager, for each database, open the Database
Properties dialog box and select Allow database to be overwritten by a
restore.

4. Delete any existing e*.log files from the storage group directories.
5. Use the NetWorker Module software to recover the Exchange databases.
6. Reboot the computer.
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This chapter contains information that may be helpful for troubleshooting
NetWorker Module backup or restore problems. It contains the following
topics:

e “NetWorker Module Log Files”

e “-D command Line Option” on page 94

* “Problems with Scheduled Mailbox Backup” on page 94
* “nsrinfo” on page 95

e “Windows 2000 Event Log” on page 95

e “Windows 2000 Support Tools” on page 96

* “Active Directory Connection Problems” on page 96

e “Microsoft Web Site Information” on page 97

NetWorker Module Log Files

The NetWorker Module backup and recover programs (nsrxchsv.exe and
nsrxchrc.exe) log their activity and error messages to log files on the client
machine. The backup log file is named nsrxchsv.log  and the recover log file
is named nsrxchrc.log . Both files are located in the
<install_path>:\nsr\applogs directory (for example, c:\ Program
files\nsr\applogs). Nsrxchsv.log  isupdated by scheduled or manual backups.
Nsrxchrc.log  is updated when a restore (restores are manual only) is
performed.

nsrxchsv.exe and nsrxchrc.exe will append current activity to an existing log,
or create a new log if none exists. Users can delete these logs files if there is no
need to keep the information.
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These log files should be provided for Legato technical support if a problem
occurs.

-D command Line Option

The NetWorker Module backup and recover programs (nsrxchsv.exe and
nsrxchrc.exe) both accept the -D command line switch. The —D switch is used
to specify the level of debug output from the program. The format of this
option is -D n where n is a number between 0 (none) and 9.

The —D option is currently only supported from the command line. It is not
possible to specify —D from the UL

Problems with Scheduled Mailbox Backup

Scheduled backups are initiated by the NetWorker Remote Exec service
(nsrexecd.exe) on the client machine. The NetWorker Client installation
configures this service to run under the local System account. This will cause
problems with scheduled mailbox backup because the local System account
does not have the required privileges. For example, the scheduled backup may
fail with the error:

OpenMsgStore() = 0x8004011d: The Microsoft Exchange Server
computer is not available. Either there are network problems or
the Microsoft Exchange Server computer is down for maintenance.
(Microsoft Exchange Server Information Store)

To identify which account is being used for the scheduled backup check the
nsrxchsv.log file. It identifies the user name that invokes the backup. The
following example was taken from a backup that was run from the local
System account:

Computer Name: ITCHY User Name: SYSTEM
To correct this problem:

1. Edit the NetWorker client resource to specify the name of an account with
sufficient privileges to backup Exchange mailboxes. This is typically the
name of the account used to install Exchange server.

2. On the client resource select the Remote tab.

3. Enter the correct user name in the Remote User field, and enter the
password in the Password field.
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4. Ensure the following requirements are met:

a. The user is a member of the server’s Administrators group.

b. On the Exchange server, these Exchange security properties are set
for the user:

— List Contents

— Read Properties

— Administer Information Store
—  View Information Store Status
— Receive As

—  Send As

This change will be needed in the client resource for each Exchange server.

nsrinfo

nsrinfo is a NetWorker client program that can be used to display the contents
of a client index file. This can be useful to determine if a specific object has ever
been backed up, or to display the files that were backed up during a backup
sequence.

Where server is the name of the NetWorker server, and client is the name of the
desired client, the format of the nsrinfo command to display index
information for NetWorker Module backup is:

nsrinffo—s  server —n msexch client

Refer to the NetWorker command documentation for more details about using
nsrinfo (see “Appendix A: Commands, Command Options and Save Sets” on
page 99).

Windows 2000 Event Log

The Windows 2000 application event log can be a useful source of information
regarding backup or restore activity. Both Exchange Server and NetWorker
Module write information to the event log. This makes it possible to follow the
sequence of events that occur during a backup or restore.

Itis also possible to save the contents of the event log to a file (either .evt or .txt).
This event log file should be provided for Legato technical support in the event
a problem occurs.
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Windows 2000 Support Tools

The Windows 2000 CD provides some support tools that can be helpful for
diagnosing problems. For example,

¢ nltest can be used to verify that the locator is functioning. The
command nltest /dsgetdc:domain lists information about the
specified domain.

¢ netdiag performs network diagnostic tests to identify configuration
or connection problems.

To install the tools, run \ Support\ Tools\setup.exe on the Windows 2000 CD. For
more information, refer to the Active Directory Support Tools section of the
Windows 2000 online help.

Active Directory Connection Problems

DNS configuration errors are a major source of Active Directory connection
problems. Both the primary and secondary DNS server must have a valid
entry for the host. This can be verified by using nslookup host_narme
primary_dns_server and nslookup host_name secondary_dns_server where host_narme
is the name of the Windows 2000 computer.

Windows 2000 Advanced Server allows Power Management to turn off the
NIC. Make sure that this option is not enabled.

In an MSCS cluster the private network configuration is important to insure
correct operation. Refer to Microsoft knowledge base article Q258750 for
recommendations on configuring the cluster private network.

Cluster failover problems can occur if DNS is not configured correctly. The
primary and secondary DNS server must have valid host entries for each
physical node and each virtual server. Failover will not work if the virtual
server host entries are not valid.

The following tools are useful for diagnosing Active Directory connection
problems:

1. Run the Active Directory Users and Computers application (dsa.msc). This
is installed on all Windows 2000 machines, but does not appear in the
Administrative tools unless the machine is a domain controller. If dsa.msc
is unable to reliably connect to the Active Directory, you have a network
configuration problem.
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2. The netdiag tool from the Windows 2000 Support Tools provides
diagnostic information. Install the support tools from the Windows 2000
CD, in the Support\Tools directory.

Microsoft Web Site Information

The Microsoft Exchange web site (www.microsoft.com/exchange) is a good
source of information about Microsoft Exchange 2000 Server.

The Microsoft Developer Network web site (www.msdn.microsoft.com) provides
information on Exchange 2000 Server, Windows 2000, and other Microsoft
products.
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Appendix A: Commands, Command Options and

Save Sets

This appendix provides syntax, notation, and related information for Legato
NetWorker commands and command options related to NetWorker Module
for Microsoft Exchange Server. It contains the following sections:

“NetWorker Module Commands” on page 99
“NetWorker Module Command Options” on page 100
“Backup Command” on page 102

“Backup Command Options” on page 102

“Save Set Specifications” on page 100

“Recover Command” on page 105

“Recover Command Options” on page 106

“Command Options for Microsoft Clusters” on page 107

NetWorker Module Commands

The following commands are used by Legato NetWorker Module, to back up
and recover Microsoft Exchange Server data:

nsrxchsv: Backup command -- backs up specified Exchange Server
objects

nsrxchrc: Recover command -- recovers specified Exchange Server
objects
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NetWorker Module Command Options

Command options modify the backup and recover commands, allowing you
to set backup types, levels, and other parameters. The command options can
be implemented by means of the NetWorker Administrator program or by
typing the full NetWorker Module commands and options at a Windows

command prompt.

The NetWorker Administrator software supports the command line options
accepted by nsrxchsv.exe and nsrxchrc.exe.

Save Set Specifications

To perform a manual backup from the command line, enter the backup
command and one or more save set specifications (Table 7)

Table 7. Save Set Specifications and Descriptions

Save Set Specification

bave Set Description

MSEXCH: Process all ESE-enabled applications on the
server. Currently IS, SRS, and KMS. This
DOES NOT include all private mailboxes.
MSEXCH:IS AlLIS storage groups.

MSEXCH:IS/<storage_group>

All databases in a storage group.

MSEXCH:IS/<storage_group> / <database>

A specific information store database.

MSEXCH:KMS

All KMS storage groups

MSEXCH:KMS / <storage_group>

A specific KMS storage group.

MSEXCH:KMS / <storage_group> / <database>

A specific KMS database.

MSEXCH:SRS

All SRS storage groups.

MSEXCH:SRS/ <storage_group>

A specific SRS storage group.

MSEXCH:SRS / <storage_group>/ <database>

A specific SRS database.

MSEXCH:MB

All private mailboxes

MSEXCH:MB / <mailbox>

A specific private mailbox
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Example:

MSEXCH:IS/Engineering Group/Engineering
MSEXCH:MB/Tom Franklin

The above specifications indicate both the database named Engineering in the
Engineering Group storage group and Tom Franklin’s private mailbox.

Notes

e Items containing white space must be enclosed in double quotations
when entered on a command line (that is, at a Windows command
prompt).

* Double quotes are not required when entering Save sets in the NetWorker
Administrator GUI, or in an input file.

A

Important: The Save set All, which is a NetWorker Save set rather than a
NetWorker Module for Exchange Server Save set, backs up the entire
filesystem except for Exchange Server objects. Use the Save set specifications in
Table 7 on page 100 for backing up Exchange Server objects.
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Backup Command

Command line syntax for the NetWorker backup command nsrxchsv is shown
in Table 8. The command options are listed and defined in Table 9.

Table 8. Backup Command Line Syntax

Function

Command Line Syntax

Backup

nsrxchsv  [- Cqv][- ¢ <client_name>]

[-a  <Virtual_server_name>|[-s  <NetWorker_server_name>]
[l <Backup_level>]

[-N <Name>][-b <Pool>][-g <Group>][-m<Masquerade>]
[-D <Debug_level>][-e  <Expiration_date>]

[l <Input_file>]

[MSEXCH

[MSEXCH:IS]

[MSEXCH:IS/ <Storage_group_name/ Database>]
[MSEXCH:KMB<Storage_group_name / Database>]
[MSEXCH:SR@<Storage_group_name / Database>]
[MSEXCH:MB

[MSEXCH:MB<Mailbox_name>|

Backup Command Options

The options accepted by the Backup command (nsrxchsv.exe) are listed in
Table 9.

Table 9. List of Backup Command Options

Command Option

Function

-a <Virtual_server_name> Specify MSCS virtual server name

-b <Pool>

Specify pool name

-Cc <Client_name>

Specify client name

-C Use compression
Note: Use of this feature with Exchange Server is not
recommended by Microsoft. This option is rarely (if ever) used
with Exchange.
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Table 9.

List of Backup Command Options

Command Option

Function

-D<nn> Specify level of debug output
-g <Group> Specify group name
- <Input_file> * Reads, from the specified text file, the names of the

databases and mailboxes (in addition to those specified on
the command line), that are to be backed up.

¢ If no database or mailbox names are entered at the
Windows command prompt, only those whose names
appear in the Input file are backed up (see the Input text
file example in Figure 7 on page 44).

¢ To set up an input file, enter the names that you want to
back up on the command line, or in separate lines, without
quotation marks, in a .txt file. Then, specify the input
filename in the Backup command text box under the
Remote tab (NetWorker Administrator>Edit
Client>Remote Tab).

o If the input file is not located in <install_path>:\nsr\bin file
is not in, specify the full pathname to the bin file in the
Backup Command text box under the Remote tab, using
double backslashes instead of single backslashes in the
pathname. For an example of how to do this, see Figure 8

on page 45.

Important: The Input filenames, together
with the backup command, must not exceed
64 characters in length.
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Table 9. List of Backup Command Options

Command Option fFunction

-I <Backup_level> Specify backup level.

¢ For full, incremental, or differential backups, specify
nsrxchsv and the -1 command option with the level
parameter you want, such as the incr parameter in the
command: nsrxchsv -s <NetWorker_server_name>
-1 incr

* To perform a copy level backup, enter the same command,
but omit the -1 option:
nsrxchsv -s <NetWorker_server_name>

-N Specify save set name

-n Do not save data

-q Quiet mode

-S <Server_name> Specify NetWorker server
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Recover Command

Command line syntax for the NetWorker recover command (nsrxchrc) is
shown in Table 10. The recover command options are listed and defined in
Table 11 on page 106.

Table 10. Recover Command Line Syntax

Function Command Line Syntax

Recover nsrxchrc [-erqu][-s  <NetWorker_server_name>] [-t <Browse_time>]
[-c <client_name>] [-a <Virtual_server_name>] [-1 <Input_file>]
[-1 <Backup_level>]

[-N <Name>][-b <Pool>][-g <Group>][-m <Masquerade>]

[-D <Debug_level>][-e <Expiration_date>]

[MSEXCH:]

[MSEXCH:IS]

[MSEXCH:IS / <Storage_group_name>/ <Database>]
[MSEXCH:KMS / <Storage_group_name>/ <Database>]
[MSEXCH:SRS / <Storage_group_name> / <Database>]
[MSEXCH:MB / <Mailbox_name>]
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Recover Command Options

Recover command options are listed in Table 11.

Table 11. Recover Command Options

Option Function

-a <Virtual_server_name> Specify MSCS virtual server name
-¢ <Client_name> Specify client name

-D <nn> Specify level of debug output
-e Replay only recovered logs

-f Force overwrite

-1 <Input_file> Specify Input filename

-q Quiet mode

-r Remount database

-s <Server_name> Specify NetWorker server

-t <Browse_time> Specify browse time
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Command Options for Microsoft Clusters

You can use NetWorker Module for Exchange Server to back up Exchange
servers that operate within Microsoft clusters. This section describes the use of
the-a  <wirtual_server_name> and -C = <client_name> command line options.
These options are required when NetWorker Module is used within a
Microsoft cluster environment. The -a <wirtual_server_name> and

-  <client_name> options identify the Exchange virtual server and the
NetWorker client, respectively. When the names of the Exchange virtual server
and the NetWorker client match, it is not necessary to enter both options to
back up or restore data to a virtual server. When the names of the Exchange
virtual server and the NetWorker client do not match, you must use both
options.

During a scheduled backup, the NetWorker server should send a-c  option
to the backup program. When it does, if the client and virtual server names
match, the backup operation succeeds.

Some versions of the NetWorker server software do not send the - option.
You can see whether the -C  option was sent by checking the command-line
activity logged in \nsr\applogs\nsrxchsv.log.

If the -c option does not appear in the log, add the -c or -a options to the
backup command field in the client resource.

Table 12 summarizes the uses of the-a and-c command options. An
example for using these options with the backup command and syntax
appears below the table.

Table 12. Uses of the -a and -c

Options for Microsoft Clusters

-a <Virtual_server name>

-c <Client_name>

Result

none

none

Error: use-a or-c

none

-c <Client_name>

<Virtual_server_name> must match
<Client_name>

-a  <Virtual_server_name>

none

<Client_name> must match
<Virtual_server_name>

-a <Virtual_server_name>

-c <Client_name>

<Client_name> and
<Virtual_server_name> are used as
given
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&8

Example:

Enter the following command and options at a Windows command prompt,
on <node_a> or <node_b>:

nsrxchsv -s <NetWorker_server_name> -a  <Virtual_server_name>
-c  <Client_name> -l  <Backup_level> MSEXCH:IS
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Appendix B: Error Messages

This appendix lists error messages you might encounter while using
NetWorker Module for Microsoft Exchange Server. The appendix provides
suggestions to resolve the problems described in the messages. The appendix
contains the following sections:

* “Microsoft Exchange Server Error Messages” on page 109
e “NetWorker Error Messages” on page 110
e “NetWorker Module Error Messages” on page 110

Microsoft Exchange Server Error Messages

When NetWorker Module for Microsoft Exchange Server encounters a
Microsoft Exchange Server error or condition requiring a warning during a
backup or recover operation, it writes a description of the error to the
nsrschsv.log and nsrxchre.log files, as well as the Event Log. Refer to the
documentation provided with your Microsoft Exchange Server software for
more information on Microsoft Exchange Server error messages and their
resolution.

NetWorker Module for Microsoft Exchange Server performs reliable backup
and recovery of Microsoft Exchange Server databases. NetWorker Module is
cannot correct errors caused by Microsoft Exchange Server. If Microsoft
Exchange Server does not start or does not run properly, consult the Microsoft
Exchange Server documentation, knowledge base, or technical support.
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NetWorker Error Messages

NetWorker Error Messages

NetWorker error messages are displayed in the NetWorker Administrator
window. The display lists the messages encountered during the past 24 hours.

For complete information about NetWorker error messages, refer to the Legato
NetWorker Administrator’s Guide.

NetWorker Module Error Messages

The error messages in this section are specific to the NetWorker Module
software.

A full backup will be performed.

A non-Full backup level was specified but can not be performed. Verify that
circular logging is not enabled. Also verify that a full backup is performed for
all databases in a storage group before attempting an incremental or
differential backup.

Backup level converted from n to 1.

The backup program converts any differential level between 2-9 into a level 1.

Bad backup level

An invalid backup level was specified with the -1 option.

Cluster backup requires use of -c or -a (or both).

In the MSCS cluster environment you must use the —a and/or —c options to
identify the virtual server name and client index.

Cluster recover requires use of -c or -a (or both).

In the Microsoft cluster environment you must use the —a and/or —c options to
identify the virtual server name and client index.
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Could not determine overwrite status for sg_name / db_name

The recover program could not determine if the specified database has the
“database can be overwritten by a restore” property set.

Database sg_name / db_name cannot be overwritten by restore.

The specified database does not have the “database can be overwritten by a
restore” property set. A database can not be restored unless this property is set.

Error creating PerfMon update thread. error_text

The backup or recover program was unable to start the Performance Monitor
update thread.

Error loading ESE dll. Status: error_code

An error occurred when NetWorker Module attempted to load the Exchange
backup .dll file.

Error on get_server_dn: error_code, error_text

NetWorker Module was unable to obtain the server distinguished name from
Active Directory. This may be caused by a network connection problem with
the domain controller.

Error opening file: file_name

The backup/recover program was unable to open the file specified with the
-I option. Verify that the file name is spelled correctly and the file exists.

Error parsing parameter: param_string

The format of the specified command line parameter is incorrect.

Error: db_name database not mounted

An attempt was made to backup a database that is not online. Mount the
database and repeat the backup.
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Exchange Server server_name was not found.

Exchange Server server_name was not found.

NetWorker Module was unable to locate the specified Exchange server. Verify
that the server name is spelled correctly.

Internal system error,
please see nsr\applogs\xbsa.messages on the client system
for reason.

An error occurred between the backup or recover program and the NetWorker
server (for example, the NetWorker server does not have the required
enablers).

Invalid database: sg_name / db_name

An invalid database name was specified. Make sure the database name is
spelled correctly and exists on the Exchange server

Invalid storage group: sg_name

An invalid storage group name was specified. Make sure the storage group
name is spelled correctly and exists on the Exchange server.

Invalid target storage group: sg_name

The specified storage group does not exist on the server. Make sure the storage
group name is spelled correctly.

Invalid time specified: time_string

The format of the specified browse time is invalid.

Log file gap detected. Max recovered log: exxnnnnn.log

A gap was detected between the highest sequence number of the recovered
logs and the existing log files. The —e option will be used to specify the replay
of only recovered logs.
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MSEXCH:DS saveset is obsolete. Continuing...

MSEXCH:DS was specified as a target for the backup or recover program.
MSEXCH:DS is obsolete for Exchange 2000. The backup or recover program
will continue processing other valid targets.

Mailbox_name <service mailbox - no IPM data>

An attempt was made to back up a service mailbox which does not contain
IPM data. Only user mailboxes can be backed up.

No backup found, can not recover without backup

No authority for backup operation.

The account used to perform a backup is not a member of the Backup
Operators group.

No authority for recover operation

The account used to perform a recover is not a member of the Backup
Operators group.

No backup target.

An Exchange object name was not specified for the backup program.

No databases are mounted.

The storage group specified for backup does not have any databases mounted.
Mount the databases and repeat the backup.

No recovery target.

An Exchange object name was not specified for the recover program.

No Storage Group match for sg_name

An invalid storage group name was specified for the backup program. Make
sure the name is spelled correctly and the storage group exists on the server.

An attempt was made to recover a mailbox that was never backed up.
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Not enough storage is available to process this command.

Not enough storage is available to process this command.

NetWorker Module was unable to allocate memory. It may be necessary to
reduce the number of programs that are currently running.

Open Cluster error: msg_string

An error occurred when NetWorker Module attempted to open a handle to the
cluster.

Out of disk space backing up mailbox.

The disk containing \nsr\tmp does not have enough free space to back up a
mailbox.

Previous object_name backup not found

An attempt was made to recover a storage group or database that was never
backed up.

Restore must be performed on virtual server active node.

A restore operation was attempted from the node that is not hosting the virtual
server. Perform the restore on the same node that is currently hosting the
virtual server.

Unable to determine active node for virtual server server_name:
error_text

Could not determine which physical node is currently hosting the virtual
server.

Unable to get DN for storage group sg_name

NetWorker Module was unable to obtain the storage group distinguished
name from Active Directory. This may be caused by a network connection
problem with the domain controller.

Unable to get log file path for storage group sg_name.

NetWorker Module was unable to determine the path to the Exchange log files.
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Unable to locate esebcli2.dll Status: error_code

NetWorker Module was unable to locate the Exchange backup API DLL. This
could occur if the Exchange System Management components are not
installed.

Unknown host host_name

The virtual server name specified with the —a option does not exist. Check the
spelling of the server name.
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Glossary

This glossary contains terms and definitions found in this manual. Most of the
terms are specific to NetWorker products.

Administrator group

API

autochanger

backup group

Backup Operators
group

Members of this Windows NT user group usually
have all the rights and abilities of users in other
groups, plus the ability to create and manage all
the users and groups in the domain. Many
NetWorker functions can only be accomplished by
members of the Administrator group.

Acronym for Application Programming Interface,
an agreed-upon set of computer library routines
used to accomplish a task.

Mechanism that uses a robotic arm to move media
among various components located in a device
including slots, media drives, media access ports,
and transports. Autochangers automate media
loading and mounting functions during backups
and recovers.

A NetWorker client or group of clients configured
to start backing up files to the NetWorker server at
a designated time of day.

A Windows NT group whose members have the
capability to log onto a domain from a
workstation or a server, back it up, and restore the
data. Backup Operators also can shut down
servers or workstations.
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Glossary

backup volume Backup media, such as magnetic tape or optical
disk. See also “media.”

bootstrap Information that includes the server index, media
index, and configuration files needed for
recovering NetWorker after a disk crash.

browse policy Policy that determines how long entries for your
files remain in the online file index.

client file index Database of information maintained by
NetWorker which tracks every file or filesystem
backed up. See also “online client indexes.”

clone Process by which NetWorker makes an exact copy
of saved data (save sets). NetWorker can clone
individual save sets or the entire contents of a
backup volume.

clone volume Duplicated volume. NetWorker can track four
types of volumes: backup, archive, backup clone,
and archive clone. Save sets of different types
cannot be intermixed on one volume.

command line Shell prompt, where you enter commands (for
example, a DOS or C shell). NetWorker has
several command line utilities that perform the
same function as many of the commands available
through the graphical interface. See also “shell
prompt.”

daemon Program that is not invoked explicitly, but lies
dormant waiting for a specified condition(s) to
occur. See also “service.”

device Backup device (tape drive, optical drive, or
autochanger) connected to the NetWorker server;
used for backing up and recovering client files.

directory Hierarchical structure of objects that represent
each component of the organization, such as the
organization itself, recipients, and more. It allows
users to address messages and MTAs (message
transfer agents) to route the messages.
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enabler codes

filesystem

heterogeneous

information stores

information store

Information Store

information store
databases

interoperability

Key Management
Server

Special codes provided by Legato that allow you
to run your NetWorker software product. Look for
the 16-character enabler code on the certificate
included with your software.

1. File tree which is on a specific disk partition or
other mount point. 2. Entire set of all files. 3.
Method of storing files.

Heterogeneous networks are networks with
systems of different platforms that interact
meaningfully across the network.

Information stores hold the data that moves
through your system using Microsoft Exchange
Server’s messaging functions. The public
information store and the private information
store are the components of the information
stores. The information stores also maintain and
enforce data security. See also “information store.”

The back-end database that contains all messages
and data located on the Windows NT server that
houses the Microsoft Exchange Server. See also
“information stores.”

Storage technology used by Exchange to store
users' mailboxes and folders. There are two kinds
of stores: mailbox stores and public folder stores.

The public database and the private database are
databases that track the information in your
public information stores and private information
stores. The databases are part of the information
store structure.

Ability of software and hardware on multiple
computers from multiple vendors to communicate
meaningfully.

The Exchange computer on which the Key
Management Service has been installed. There can
be one Key Management server per
administrative group.
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Key Management
Service

log files

Glossary

mailbox store

MAPI (Microsoft
Messaging API)

media

media index

media manager

An optional Microsoft Exchange 2000 Server
component that is installed on a designated server
in an administrative group. It provides centralized
administration and archival of private keys, and
maintains every user's private encryption key in
an encrypted database. The keys are used for
encrypting e-mail messages and signing messages
with digital signatures.

The log files for a storage group contain the
database transactions for all mailbox stores or
public folder stores in the group. For this reason,
the storage group is the best unit for backup,
because backups automatically include the
transaction logs for all mailbox stores or public
folder stores in the group.

To optimize performance, dedicate separate
physical drives for the log files of your storage
groups. When each set of log files has its own
physical drive, server performance improves. To
optimize fault tolerance, use hardware mirroring
with redundant array of independent drives
(RAID).

The part of Information Store that maintains
information in user mailboxes. A mailbox store
consists of a rich-text .edb file, plus a streaming
native Internet content .stm file.

Set for messaging applications that is widely
supported by messaging vendors, primarily
attributable to Microsoft.

Magnetic tape or optical disks used to store
backed-up files. See also “backup volume.”

Database of information maintained by
NetWorker which tracks every backup volume.

The NetWorker component that tracks save sets to
backup volumes. The nsrmmdbd service is
responsible for making entries in the NetWorker
online media index.
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Microsoft Cluster
Server (MSCS)

Microsoft Exchange
Client
mount

multiplex

Multiple Information
Stores and Storage
Groups

NetWorker client

NetWorker server

NetWorker User for
Exchange Server

Built-in feature of Windows NT Server, Enterprise
Edition. It is software that supports the connection
of two servers into a “cluster” for higher
availability and easier manageability of data and
applications.

Program that a client uses to read, write, and
manipulate the post office and folders.

To make a database available for use or to place a
removable tape or disc into a drive.

Method of transmitting multiple streams of data
simultaneously through the same channel.

Exchange supports multiple databases contained
within a storage group. A storage group includes
one to five databases and one set of transaction log
files for all databases in the storage group. You can
create a maximum of four storage groups on one
server.

If each storage group contains the maximum of
five databases, you can create a maximum of 20
databases on one server.

You can use multiple databases to increase the
number of simultaneous users on a server and
lessen the risk of a damaged database. Because the
size of each database is decreased, data recovery is
faster and does not require the server to be offline.

A computer that can access the backup and
recover services from a NetWorker server. Clients
may be workstations, PCs, or fileservers.

Computer on a network running the NetWorker
software, containing the online indexes, and
providing backup and recover services to the
clients on the same network.

Client’s graphical user interface for the NetWorker
Module for Microsoft Exchange Server. From this
interface you can initiate unscheduled backups as
well as recoveries.
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Glossary

notice

nsrhost

object

online client indexes

OST (offline message
store)

PAB (personal
address book)

PDC (primary
domain controller)

pathname

permission

properties

PST (personal storage
files)

Response to a NetWorker event.

Logical hostname of the computer that is the
NetWorker server.

Record in the Microsoft Exchange Server
directory. A site, server, mailbox, folder, and file
are all examples of objects.

Databases on a NetWorker server that contain
information pertaining to client backups and
backup volumes. See also “client file index.”

Message store (typically on a user’s hard disk)
that stores messages locally and allows for
replication of information between the client and
the server.

User’s list of recipients. The file physically resides
on the user’s workstation.

Server in a Windows NT Server domain where
changes are made to user accounts.

Instructions for accessing a file. An absolute
pathname tells you how to find a file beginning at
the root directory and working down the
directory tree. A relative pathname tells you how to
find the file starting where you are now.

Rights given to a user to perform specific actions
on an object. Read-only is an example: It allows a
user to read, but not alter a file.

Attributes of an object, such as the display name
of a recipient.

Client-side message store for use by Microsoft
Exchange Client and Microsoft Outlook. Typically
resides on a user’s workstation.
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public folder store

recover

recycle

registry

resource

retention policy

save

save set

The part of Information Store that maintains
information in public folders. A public folder store
consists of a rich-text .edb file, plus a streaming
native Internet content .stm file.

The NetWorker command used to browse the
server index and recover files from a backup
volume to a client’s disk.

A volume whose data has passed both its browse
and retention policies and is available for
relabeling and reuse.

Database of configuration information central to
Windows NT operations. The overall effect
centralizes all Windows NT settings and provides
control over system, security, and user account
settings.

Resource represents a component of the
NetWorker software that describes the NetWorker
server and its clients. Devices, schedules, clients,
groups, and pools are all examples of NetWorker
resources. Each resource contains a list of
attributes, defining the parameters to use for the
configured NetWorker resource. Use the
NetWorker administration program to configure
NetWorker resources and their attributes.

Policy that determines how long to retain entries
in the media index for recovery.

The NetWorker command that backs up client
files to backup volumes and makes data entries in
the online index.

Set of files or a filesystem that NetWorker has
backed up onto backup media during a backup
session. Save sets are assigned a “save setid,” an
internal number which identifies the backup
session to NetWorker for subsequent restoration
to primary disk.
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save set ID

scanner

service

shell prompt

Site Replication
Service

stand-alone device

storage group

storage manager

volume

Internal identification number assigned to a save
set by NetWorker.

The NetWorker program used to read a backup
volume when the online indexes are no longer
available.

Program that is not invoked explicitly, but lies
dormant waiting for a specified condition(s) to
occur. See also “daemon.”

Cue for input in a shell window where you enter a
command. See also “command line.”

A directory service (similar to the directory used
in Exchange Server 5.5) implemented in Exchange
2000 to allow the integration with downstream
Exchange 5.x sites using both RPC and mail-based
replication. Site Replication Service works in
conjunction with Active Directory Connector to
provide replication services from Active Directory
to the Exchange 5.x Directory Service.

Backup device that contains a single drive for
backing up data. Stand-alone devices cannot store
or automatically load backup volumes.

A collection of mailbox stores and public folder
stores that share a set of transaction log files.
Exchange manages each storage group with a
separate server process.

Application that manages the storage devices and
media used for backup and restore requests.
NetWorker Module is a storage manager that
connects NetWorker services to Microsoft
Exchange Server to provide storage management
for databases and transaction logs.

Backup media, such as magnetic tape or optical
disk. See also “media.”
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volume ID

volume name

volume pool

Windows NT Server
domain

XBSA

Internal identification assigned to a backup
volume by NetWorker. The volume ID is entered
in the NetWorker server’s media database for
volume policy management.

Name you assign to a backup volume when it is
labeled internally by NetWorker.

Feature that allows you to sort backup data to
selected volumes. A volume pool contains a
collection of backup volumes to which specific
data has been backed up.

Collection of Windows NT servers administered
as a single unit.

Acronym for X/Open® Backup Services
Application Programming Interface, which
connects NetWorker functionality to NetWorker
Module. For more information about X/Open,
visit the X/Open web site at www.xopen.org.
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using 35
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Configure for a Directed Recovery 72

D

daemon, description of (See also service)
118

device, description of 118

directory, description of 118

E

e-mail
"savegroup completion” notification
49
enabler codes, description of 119
error messages 109

F

figures
NetWorker process during BusinesSuite
Module restore 21
NetWorker process during NetWorker
Module backup 20
file index
(See also client file index)
description of 118
filesystem, description of 119

H

heterogenous, description of 119
how to
configure BusinesSuite Module 33

Legato NetWorker Module for Microsoft Exchange Server

Administrator’'s Guide

127



Index

Index
I-S

information store and databases, description
of 119

information stores, description of 119

Installation Guide, typefaces and symbols
explained 14

interoperability, description of 119

L
label template 46

M

mailbox backup, description of 34
MAPI (Messaging API) 120
media

database 19-20, 35

description of 120
media index

description of 120
media manager, description of 120
Microsoft Cluster Server (MSCS), description

of 79,121

Microsoft Messaging API (MAPI) 120
MSCS (Microsoft Cluster Server) 79,121
multiplex, description of 121

N

NetWorker
client, description of 121
features highlighted 18
resource, description of 123
server, description of 121
NetWorker Module
backup, graphic of 20
NetWorker User for Exchange Server,
description of 121
notice, description of 122
notification, e-mail 50
nsrd

functionality =~ 19-20
nsrhost, description of 122
nsrmmd

functionality during recover 20
nsrxchrc 99
nsrxchsv 99

O

object, description of 122
online indexes 122
options

Autostart 35

P

pathname, description of 122
Prepare the NetWorker Server for the
Directed Recovery 73

R

recover
description of 123
nsrxchrc command, description of 99
Recovering a Private Mailbox from a
Database Backup 72
Recovering Exchange Server Data 67
recycle, description of 123
Registry 123
restore 21
retention policies 123
retention policy

using 35
S
save
description of 123
save set

identification (ssid) 124
save set(s) 47,123
savegroup completion report 19

128

Legato NetWorker Module for Microsoft Exchange Server
Administrator’'s Guide



Index
T-X

savegrp
functionality 19
scanner 124
scheduled backup(s) 19
services
description of (See also daemon) 124
shell prompt, description of 124
stand-alone device, description of 124
Start a Recovery 67
storage manager, description of 124

T

transaction logs 46

U
Use the Show Versions Dialog Box 65

\%

volume
ID, description of 125
name, description of 125
volume pools
using 46
valid types 47

XBSA
NetWorker
(See also NetWorker XBSA)

Legato NetWorker Module for Microsoft Exchange Server
Administrator's Guide 129

Xapu|



Index
X-X

Legato NetWorker Module for Microsoft Exchange Server
130 Administrator’s Guide



	Contents
	Preface
	Product Documentation
	Conventions
	Information and Services
	General Information
	Technical Support
	Customer Service

	Customer Feedback

	Chapter�1:� Introduction
	Importance of Backing Up Microsoft Exchange Server Data
	Using NetWorker Software to Protect your Network
	Using NetWorker Module to Protect your Exchange Servers

	How NetWorker Module and NetWorker Work Together
	Client-Server Model
	Backup Process
	Restore Process


	Chapter�2:� Backup Types and Levels
	Overview of Backup Types and Levels
	How Scheduled Backups are Processed
	How Manual Backups are Processed
	Selecting Exchange Server Objects for Backup

	What is Backed Up at Each Level
	Backup Levels - List
	Setting Backup Levels
	Scheduled Backups
	Manual Backups

	Backup Level Notation in Media Database


	Chapter�3:� Scheduled Backups
	Planning Backups
	Multiple Databases
	Planning Backup Schedules
	Private Mailboxes

	Improving Performance
	Excluding the Exchange Installable File System from Backup Operations
	How to Create a Custom Directive

	Creating and Configuring Backup Groups
	Backing Up Private Mailboxes
	Mailbox Backup Requirements

	Customizing Backup Group Parameters
	Using Browse and Retention Policies

	Implementing Scheduled Backups
	Task 1: Configure Backup Groups
	Task 2: Configure Clients
	Save Set Specifications for Storage Groups and Databases
	Save Set Specifications for Private Mailboxes
	How to Select Schedule, Browse policy, and Retention Policy

	Task 3: Enter Remote Access Accounts and Users
	Task 4: Test the Configuration
	How to Use an Input File to Specify Multiple Private Mailboxes for Backup
	Task 1: Create an Input File
	Task 2: Configure a NetWorker Backup Group
	Task 3: Create a Client Resource for the Exchange Server
	Task 4: Start the Exchange Backup Group


	Planning Backup Storage
	Using Volume Pools
	What is a Volume Pool
	How to Create a New Volume Pool
	Volume Pool Locations and Contents
	Customizing Volume Pools
	How to Customize Volume Pools


	Viewing Backup Results
	Setting up E-mail Notification of Backup Results


	Chapter�4:� Manual Operations: Backing Up and Restoring
	Manual Backups
	Performing a Manual Backup
	Task 1: Initiate a Manual Backup
	Task 2: Select and Mark Objects for Backup (or Recovery)
	Task 3: Select Backup Options
	Task 4: Perform the Backup Operation


	Performing a Data Recovery
	How to Set the Database Properties to Allow Recoveries
	How to Select and Mark Objects for Recovery
	How to Select Recover Options
	Recover Options

	Selecting a Browse Time
	Browse Time Background
	Versions Background
	Exchange Server Background
	Optimal Browse Times
	Summary - Selecting a Browse Time

	How to Change the Browse Time
	Using the Versions Dialog Box
	Versions Dialog Box Contents
	How to Use the Versions Dialog Box

	How to Start a Recovery
	Recovering Exchange Server Data
	How to Recover an Exchange Server Object
	Recovering the Key Management Server (KMS)
	Recovering the Site Replication Server (SRS)


	Recovering Private Mailboxes
	User-Initiated Recovery
	Administrator-Initiated Recovery
	How to Recover Private Mailboxes from a Mailbox Backup
	Performing a Directed Recovery of a Database
	How to Configure for a Directed Recovery
	How to Start a Directed Recovery

	Peforming a Directed Recovery of a Private Mailbox from a Database Backup
	Prerequisites
	How to Prepare the NetWorker Server for the Directed Recovery
	How to Recover a Mailbox from a Database Backup

	How to Verify a Recovery
	Recovery Recommendations

	Monitoring Backups and Recoveries
	Using the Windows Performance Monitor


	Chapter�5:� Backing Up and Recovering within Microsoft Clusters
	Using NetWorker Module in Microsoft Clusters
	Scheduled Backups
	How to Configure Scheduled Backups within a Microsoft Cluster
	How to Schedule a Backup within a Microsoft Cluster

	Manual Backup within a Microsoft Cluster
	How to Start a Manual Backup within a Microsoft Cluster
	How to Change the Virtual Server
	How to Start a Manual Backup from a Command Prompt, within a Cluster
	Using an Input File for Mailbox Names within a Microsoft Cluster
	Backup Recommendations

	Recovering an Exchange Server Database in a Cluster
	How to Start a Recovery within a Cluster
	How to Start a Recovery from a Command Prompt, within a Cluster

	Recovery Recommendations


	Chapter�6:� Disaster Recovery
	Prerequisites
	Disaster Recovery
	Task 1: Reinstall the Operating System
	Task 2: Configure the System for Recovery
	Task 3: Recover the System to the Pre-disaster State
	Task 4: Reinstall Exchange Server software


	Chapter�7:� Troubleshooting
	NetWorker Module Log Files
	-D command Line Option
	Problems with Scheduled Mailbox Backup
	nsrinfo
	Windows 2000 Event Log
	Windows 2000 Support Tools
	Active Directory Connection Problems
	Microsoft Web Site Information

	Appendix�A:� Commands, Command Options and Save Sets
	NetWorker Module Commands
	NetWorker Module Command Options
	Save Set Specifications
	Notes
	Backup Command
	Backup Command Options
	Recover Command
	Recover Command Options

	Command Options for Microsoft Clusters

	Appendix�B:� Error Messages
	Microsoft Exchange Server Error Messages
	NetWorker Error Messages
	NetWorker Module Error Messages
	A full backup will be performed.
	Backup level converted from n to 1.
	Bad backup level
	Cluster backup requires use of -c or -a (or both).
	Cluster recover requires use of -c or -a (or both).
	Could not determine overwrite status for sg_name / db_name
	Database sg_name / db_name cannot be overwritten by restore.
	Error creating PerfMon update thread. error_text
	Error loading ESE dll. Status: error_code
	Error on get_server_dn: error_code, error_text
	Error opening file: file_name
	Error parsing parameter: param_string
	Error: db_name database not mounted
	Exchange Server server_name was not found.
	Internal system error, please see nsr\applogs\xbsa.messages on the client system for reason.
	Invalid database: sg_name / db_name
	Invalid storage group: sg_name
	Invalid target storage group: sg_name
	Invalid time specified: time_string
	Log file gap detected. Max recovered log: exxnnnnn.log
	MSEXCH:DS saveset is obsolete. Continuing...
	Mailbox_name <service mailbox - no IPM data>
	No backup found, can not recover without backup
	No authority for backup operation.
	No authority for recover operation
	No backup target.
	No databases are mounted.
	No recovery target.
	No Storage Group match for sg_name
	Not enough storage is available to process this command.
	Open Cluster error: msg_string
	Out of disk space backing up mailbox.
	Previous object_name backup not found
	Restore must be performed on virtual server active node.
	Unable to determine active node for virtual server server_name: error_text
	Unable to get DN for storage group sg_name
	Unable to get log file path for storage group sg_name.
	Unable to locate esebcli2.dll Status: error_code
	Unknown host host_name


	Glossary
	Index

